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PREFACE

OASYS is domestic trade allocation and acceptance service for the U.S. OASYS automatically communicates
trade and allocation details between investment managers, broker/dealers, and custodian banks.
This user guide describes how to:
•

Connect to the OASYS host

•

Enter equity and fixed income trades

•

Enter stepout information for equity and fixed income trades

•

Modify the OASYS tables

•

Backup and restore the OASYS tables in the database (for example, Accounts and Equity Broker)

•

Print trade reports

•

Configure schedules to automatically import or export trades

•

Use the OASYS-TradeMatch Service

Audience
This user guide is intended for investment managers who use OASYS to process allocations for equity and fixed
income trades. It is assumed that you have a basic understanding of electronic trade and transaction processing
concepts.

Changes in This Version of the Document
This version of the document includes changes to conform with current DTCC branding guidelines.

Related Documents and Training
For related documents and training in the DTCC Learning Center, go to Institutional Trade Processing → OASYS

Questions?
The DTCC Contact Center (CCC) provides general assistance and technical help. Visit www.dtcc.com/clientcenter to:
•

Enter a service request or check the status of an existing service request

•

Search our knowledge base

•

Obtain contact information
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1. GETTING STARTED
Introduction
This chapter describes how to start the workstation, work on the Trade Summary screen, and view a trade
reference number.

Starting the Workstation
An OASYS host connection to the primary workstation must be in working order to run the software. For
information on setting up the connection, see the Installation Guide.
To start the workstation:
1. Do one of the following:
•

Double-click the OASYS icon

on your desktop.

•

From Start on the Windows taskbar, select All Programs, and then select Omgeo OASYS 7.0.

The Trade Summary screen appears. Figure 1.1 shows an example of the Trade Summary screen with four
pre-loaded trades (the first two show allocation listings).

Figure 1.1 OASYS Trade Summary Screen
Note

Depending on your step in the setup process, there can be trades loaded in the Trade Summary screen. See
the Integration Guide for more information about importing/exporting trades and trade models.

2. Click Connect
to connect to the DTCC host and download the latest OASYS tables. The tables are fully
described in About OASYS Tables.

Working in the Trade Summary Screen
The Trade Summary screen displays information about equity and fixed income trades. From this screen, you
can access all OASYS functions required to process trades.
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It includes the following components:
•

The title bar contains the name of the active filter.

•

The menu bar and the toolbar (top of the screen) provide access to all the OASYS screens and functions
used to process trades.

•

The bar at bottom of the screen provides status information. To help you quickly identify a trade status,
select a color for each status.

•

The display area shows both equity and fixed income block trades and their allocations. When you expand
a trade, its allocations appear underneath the associated block. The data fields include:
•

Status indicators

•

Expand/Collapse button

•

Block Details

•

Status Values

•

Number of Allocations

•

Trade Date and Time

•

Reference #

Table 1.1 provides a description of the Trade Summary screen fields.
Table 1.1 Trade Summary Screen Fields
Field Name

Description

Status Indicators
Purple or Green Dot

A dot indicating that messages are ready to be sent to the OASYS host.
• Purple indicates that the trade is in a transmittable state but you can still edit it.
• Green indicates that the trade is in a transmittable state and has already been queued for transmission. You can
view, but not edit, the trade.

OASYS-TradeMatch
Yellow Dot

(OASYS-TradeMatch) Indicates that a trade was successfully transmitted to the TradeMatch system. It appears after the
Green dot displays.

Green Up Arrow (solid)

(OASYS-TradeMatch) Indicates that a trade successfully passed the TradeMatch criteria and was added to its system for
comparison. It does not mean that the trade is successfully matched.

Green Up Arrow (hollow)

(OASYS-TradeMatch) Indicates that a trade successfully passed the TradeMatch criteria. but it contains soft errors. A soft
error indicates that data associated with the TradeHub™ custodian allocation feature is missing and the allocation is not
forwarded to the custodian. However, this data is not critical to the processing of block trades or allocation details.
• Example 1:
The institution's custodian is not a TradeHub subscriber and therefore, the information cannot be forwarded to
custodian.
• Example 2:
The Agent ID and AIA# are missing in LERT.

Red Down Arrow

(OASYS-TradeMatch) Indicates that a trade contains a hard error and is, therefore, invalid. TradeMatch cannot process
the entire block trade nor match the allocation to confirm it. You can view the error in the TradeMatch Errors screen.
• Example 1 (block):
The ticker is invalid and the entire trade did not process.
• Example 2 (allocation):
The Inst ID field was not found for the allocation in ALERT.

Expand/Collapse Button
+ or - button

Allows display of trade data to be expanded from block to block/allocations (+) and collapsed back to block only (-). You
have the option of selecting a color for the button to indicate step-outs.
(OASYS-TradeMatch) When you expand a trade to view the allocations, the matching status displays on each allocation
processed in TradeMatch.

Trade Details
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Table 1.1 Trade Summary Screen Fields (continued)
Field Name

Description

Trans

Bought/Sold Indicator (B/S), an abbreviation of the transaction.

Security/Account

• For a block trade, the name of the security.
• For an allocation, the account name.

Asset Class

Identifies whether the trade is for an equity (EQ) or fixed income (FI) security type.

Security Type

Identifies the security type:
• EQ (Equity)
• FI (Fixed Income)

Size/Quantity

The quantity of the financial instrument.

Price

Transaction price per unit of the financial instrument.

Comm

Commission (special concession).

Counterparty/BOC

• If a block, Broker Short Name from the broker table is displayed.
• If an allocation, Broker of Credit Name is displayed.

Status Values
Status

The status of the trade or allocation. The trade values include:
• ACCRCVD—institution received an ACCEPT from the broker. Final status of the trade.
• ALLOC—trade has been fully allocated.
• CANCEL—you have canceled the trade.
• CNCLD—broker has received the canceled trade.
• DUPL—trade is a copy of an earlier trade.
• INCMPL—trade is missing required information.
• NALLOC—trade is entered on your workstation; the allocations are either less than or greater than 100%, or the
price was not specified.
• RCVD—broker workstation has received the trade.
• READY—trade is ready for transmission to OASYS.
• REJECT—broker has rejected the trade.
• SENT—trade has been sent to the OASYS host.
• When you expand the trade in OASYS-TradeMatch, the matching status displays on each allocation processed in
TradeMatch.

Number of Allocations
# Alloc

Displays the total number of allocations for the block.

Trade Date and Time
Trade Date

The security’s trade date.

Time

The time the security was traded.

Trade Reference Number
Reference #

OASYS trade reference number assigned by the workstation after you enter a trade manually or through the Import
function. See Viewing a Trade Reference Number in the next section of this chapter for more information.
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Reviewing the Toolbar
The icons on the Trade Summary screen toolbar are described in Figure 1.2.

Figure 1.2 OASYS Trade Summary Screen Toolbar
Table 1.2 describes the toolbar icon functions.
Table 1.2 Toolbar Icon Functions
Icon

Click to...
Import trade models.
Export trade models.
Filter trade models for display.
Connect to the workstation to the OASYS host.
Disconnect the workstation from the OASYS host.
Filter trades for display.
Sort trade models.
Print selected trades.
Display the Trade Summary screen.
Cancel a trade.
Transition a trade status to READY.
Duplicate a trade.
Open a selected trade.
Create a trade.
View the previous or next trade in the list.
View the OASYS User ID, System ID, Host ID, Data Source, and Memory Available.
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Viewing a Trade Reference Number
The OASYS workstation assigns each trade a unique eleven-digit reference number, including the decimal. The
number appears in the Reference # column of the Trade Summary screen. See Figure 1.3 for an example:

Figure 1.3 Trade Reference Number
The number breaks down as follows:
•

The first three characters are the Julian date, which corresponds to the sequential day of the year the trade
is submitted.

•

The next five characters are the trade sequence number, which is the sequential order number OASYS
assigns to the trade on that date.

The last two characters, set off by a decimal point, represent the trade version number, indicating the number of
times the trade has been amended.
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2. SETTING OASYS PROPERTIES
Introduction
This chapter describes how to set OASYS system and user properties.

About OASYS Workstation Properties
You can display workstation setup properties on the OASYS Workstation Setup and Advanced Workstation
Setup screens. Some options are set at installation and cannot be modified after installation. Other options are
read-only, unless you are the OASYS administrator.

OASYS Administrator Settings
DTCC sets administrator settings before installation. Only an administrator can change these settings with help
from the DTCC Client Center:
•

Workstation type

•

GMT offset

•

Site ID, host ID/password

•

Trade and settle date

•

User ID and password

•

Database retention

OASYS User Settings
You can change any of the following settings:
•

Security type default for new trades. For example, if you only handle equity trades, you can set EQU as the
default.

•

OASYS-TradeMatch options:
•

Default settlement location

•

Default submitting institution

•

Pre-notification to custodian option
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OASYS Workstation and Advanced Workstation Screens
In the Trade Summary screen, click Workstation Setup on the Tools menu to open the OASYS Workstation
Setup screen (Figure 2.1). Using this screen, configure the workstation, if necessary.

Figure 2.1 OASYS Workstation Setup Screen
Table 2.1 describes the OASYS Workstation Setup screen fields.
Table 2.1 OASYS Workstation Setup Screen Fields
Field

Description

System Setup
Institution/Broker

Identification of your type of OASYS workstation.

Site ID/Acronym

Your ID/acronym on the OASYS host. Typically your acronym, which you can see on your Broker Table.

Host ID

ID your workstation uses to connect to the OASYS host.

Host Password

Password your workstation uses to connect to the OASYS host.

Optionsl
GMT Offset

Difference between local time and Greenwich Mean Time. Up to 11 hours, plus or minus. This setting reflects your local
time zone. For example, EST is a five hour difference (-5), and EDT is a six hour difference (-6).

Trade Date Range
(Business Days)

Directs your workstation to refuse trades for import or manual update which are more than N business days old.

Settle Date Offset
(Business Days)

Number of business days added to the trade date to calculate the settlement date if your counterparty has not provided a
specific settlement date.

Database Retention
(Calendar Days)

Number of calendar days that trades are kept in the database before your workstation purges them.

Security Type

Type of equity or fixed income financial instrument such as SHP (preferred shares) and MBS (mortgage-backed securities).
You can set the default on the OASYS Workstation Setup screen.

Settlement Location

(OASYS-TradeMatch) On the allocation, identifies a valid settlement location. Once you select a default settlement location,
it is also copied to the allocations.

Submitting Institution

(OASYS-TradeMatch) On the trade block, the TradeMatch ID of the submitting institution.

Pre-Notify Custodian

(For OASYS-TradeMatch clients) On the trade block, indicates that the trade is sent to a custodian.

Communication
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Table 2.1 OASYS Workstation Setup Screen Fields (continued)
Field

Description

Dial-in Active

Check box indicates whether your workstation can dial in to host.

Receive Timeout

Length of time in seconds that your workstation waits for messages from the OASYS host before assuming a line failure.

Default

Click to return to the original installation settings.

Advanced button

Displays the Advanced Workstation Setup screen.

User Setup
User ID

Your ID to log in to your OASYS workstation.

User Password

Asterisks representing your password.

Advanced Workstation Setup Screen
Click Advanced on the right side of the OASYS Workstation Setup screen to open the Advanced Workstation
Setup Screen (Figure 2.2).

Figure 2.2 Advanced Workstation Setup Screen
Table 2.2 describes the screen fields.
Table 2.2 Advanced Workstation Setup Screen Fields
Field

Description

Communication Configuration
Host Port

Communication port on the OASYS host.

Source Port

Communication port on you local workstation. The default value is zero (0), which means OASYS can use any
workstation port. We recommend that you use the default (0), to avoid conflicts with other applications.

Frame Blocking
Maximum Trades Blocked

Maximum number of trades to send at one time to the OASYS host and receive from the host. The default is 10.

Configuring the Connection to the Host
The Connection option on the Tools menu opens the Connection Configuration screen, where you can:
•

View, select, and configure a network connection.

•

View the host address for your connection.
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•

Set the amount of idle time allowed before the workstation disconnects.

•

Set how many times OASYS tries connecting to the host using one phone number before it tries the next
number.

•

View your workstation’s connection statistics (login time, total successful sessions, total failed attempts to
connect) on the Connection Statistics screen.

To configure the OASYS host:
1. Select Connection on the Tools menu in the Trade Summary screen.
The Connection Configuration screen appears (Figure 2.3).

Figure 2.3 Connection Configuration
Note

This option overrides the scheduled communication configurations. You can view the status of the
communication by double-clicking the OFFLINE/ONLINE status bar.

2. Accept or modify the defaults in the Hangup Delay and Max Retries fields.
3. In the Network Connections section, select the Active check box.
4. Select the connection method from one of the Network Connection drop-down list items, depending on your
system configuration.
5. Click Configure if available. Local Area Network and F5 SSL VPN connections are standard DTCC
connections and do not require additional configuration.
6. Type your user name and password in the User and Password fields.
7. Type the OASYS host in the Host Address field.
8. Click OK.
Table 2.3 describes the screen fields.
Table 2.3 Connection Configuration Screen Fields
Field

Description

Connection Configuration Screen
Statistics button

Click to display the Connection Statistics screen and view the information about your workstation’s connections to the
OASYS host.

Connection
Hangup Delay

Idle time allowed before the connection to the host is automatically terminated. Maximum: 9 minutes, 59 seconds.
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Table 2.3 Connection Configuration Screen Fields (continued)
Field

Description

Max Retries

Number of times to try to connect to the OASYS host if a connection fails. OASYS tries each connection once and then, if
it fails, moves to the next connection.

Network Connection
Active check box

Click to select a network connection for use. You can activate up to five connections.

Network Connection

Name of the network connection.

User

Name used to identify the network connection user.

Password

User password.

Host Address

OASYS host address, supplied by DTCC.

Configure

(Advanced) Click to open the configuration property screen for the connection. Use only to set up a connection that is not
one of the defaults from DTCC.

New button

Click to create a specialized dial-up network connection.

Checking Connection Statistics
In the Connection Configuration screen, click Statistics to view the system connection log for the information
described in the Table 2.4.
Table 2.4 Connection Statistics
Display Field

Description

First Login Today

Date and time of first the log on to the host today.

Total Login Time

Total time your workstation has been connected to the host today.

Total Successful Sessions

Number of successful logins today.

Total Failed Attempts

Total failed login attempts today.

Last Successful Login

Last date and time system successfully logged on to the host.

Last Failed Login

Last date and time system attempted to log on host but failed.

Changing Trade Status and Stepout Colors
To help you quickly identify a trade's status on the Trade Summary screen, you can select a trade color based on
its status. Some trade status colors are already set by default:
•

CANCEL

•

CNCLD

•

REJECT

•

ACCEPT
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To change a trade color:
1. Select Trade Status Colors from the Tools menu. The Colors screen appears (Figure 2.4).

Figure 2.4 Colors Screen
2. In Background Color, select a color scheme using the radio buttons. You can also select the Grid Lines check
box to show grid lines on the Trade Summary screen.
3. Follow the directions on the screen to select a status and corresponding color scheme. The selected status
displays the color you chose.
4. To return to the default colors, click Defaults.
5. Click OK to save your changes or click Cancel to exit without saving your changes.
To change a stepout allocation indicator color:
1. Select the Stepout Allocations Indicator Color tab.
2. Click Select Color and choose a color in the Color screen.
3. Click OK, and then click OK again in the Color screen to confirm your choice.

Setting a Default Security Type
Use this field if you deal primarily in one security type, such as corporate bonds (COB).
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To set a default security type:
1. Select Workstation Setup from the Tools menu. The OASYS Workstation Setup screen appears.

Figure 2.5 OASYS Workstation Setup Screen
2. In the Security Type field under Options on right side of the screen, select the default security type for new
trades.
Once you select a default security type, you do not have to use this field in your import file. To change the
value, populate the field with a new value in your import file, or manually change it in the Block Details
screen.
3. Click OK to save your changes or click Cancel to exit the screen.

Setting OASYS System Properties
You can set up these defaults for OASYS on the System Properties screen:
•

Settings—Defaults for date and time formats, filters and sort models, report format, report font size, and
event log verbosity.

•

Import/Export—Import and Export models. See the Integration Guide for more information about import/
export.

•

Preferences—Preferences for Auto Ready. The preferences are:
•

Confirming a delete

•

Calculating commission

•

Entering the Security ID in uppercase

•

Filtering allocation details from broker/dealers

•

Checking for unique allocation internal reference numbers

•

Displaying the counterparty name by firm name or OASYS acronym

Note

The System Properties settings are applied at the beginning of a login session. If you change a setting and
want to apply it, log out, and then log back in.
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Specifying System Settings
Enter defaults for your OASYS workstation on the Settings sheet of the System Properties screen.
To change the OASYS system setting defaults:
1. Select System Properties from the Tools menu. The System Properties screen appears and displays the
Settings sheet (Figure 2.6).
.

Figure 2.6 System Properties Screen
2. Select the date and time format to display on OASYS screens and reports in the Date Format and Time
Format drop-down lists, respectively.
3. Select defaults to filter and sort the trades on the Trade Summary screen in the Default Filter and Default
Sort drop-down list, respectively.
4. Select the default format and font size for the OASYS reports in the Default Report Format and Default
Report Font Size drop-down lists, respectively.
5. Choose the message level you want recorded in the event log from the System Event Verbosity drop-down
list.
Note

Only select All Messages under the direction of a DTCC representative.

6. Select the Display Table Update Message check box to display a message whenever table information
updates by a data download from the OASYS host.
7. Select Restore Default Columns on Exit check box to restore the default columns and widths on the Trade
Summary screen when you exit OASYS. Clear this check box to retain any personal preferences you set for
the Trade Summary screen.
8. Click OK to save your changes or click Cancel to exit the screen.
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Specifying Import/Export Models to Display
If you import or export trades, you can select the default import/export models. You can also indicate the name of
the model to display when an import or export is run. Enter defaults for your import/export models on the Import/
Export sheet of the System Properties screen.
For more information on setting up import and export models, see the Integration Guide.
To select the default import and export models:
1. Select System Properties from the Tools menu.
The System Properties screen appears.
2. Click the Import/Export tab (Figure 2.7).

Figure 2.7 Import/Export Tab
3. Select a default import model in the Import Model drop-down list.
4. To display the model name on the Import Model screen, select the Display Model When Import Run check
box.
5. Select a default export model in the Export Model drop-down list.
6. To display the model name on the Export Model screen, select the Display Model When Export Run check
box.
7. Click OK to save your changes or click Cancel to exit the screen.

Specifying Preferences
You can enter the defaults for displaying specific OASYS screens, messages, and actions on the Preferences
sheet of the System Properties screen.
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To set preferences:
1. Select System Properties on the Tools menu. The System Properties screen appears.
2. Click the Preferences tab (Figure 2.8).

Figure 2.8 Preferences Tab
3. Select the Auto Ready check box to set allocated trades to a READY status automatically.
4. Select the Confirm Delete check box to display a message confirming that you really want to delete an Import,
Export, or Filter model.
5. Select the Calculate Commission check box to have the commission calculated on the allocation screen.
6. Select the Enter Security ID in Upper Case check box to have the security identification entered in capital
letters.
7. Select the Filter Allocation Details for All Brokers check box to filter stepout allocation details from the
broker.
8. Select the Check for Unique Allocation Internal Reference Numbers check box to ensure that all
allocations include unique internal allocation reference numbers.
9. Under Display Counterparty, select one of the following radio buttons:
•

By Firm Name to display the firm name followed by the OASYS acronym in the OASYS Broker/
Stepout Broker field on the trade block/allocation.

•

By OASYS Acronym to display the acronym followed by the firm name.

10. Click OK to save your changes or click Cancel to exit the screen.
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3. WORKING WITH OASYS TABLES
Introduction
This chapter describes how to work with the tables created in OASYS.

About OASYS Tables
The workstation includes view-only and user-editable tables. It updates the view-only tables when you initially
connect to the host and whenever table updates are available.
Table 3.1 describes each OASYS table.
Table 3.1 OASYS Tables
Table

Description

Equity Broker

Contains available equity brokers, including:
• Long Name—automatically provided
• Acronym—automatically provided
• Short Name—automatically provided
• Internal ID—for internal mapping purposes only
• DTC Number—a four-digit number for internal mapping purposes only
Each time you connect to the OASYS host, it checks the table against your workstation table and updates the workstation
if necessary.

Fixed Income Broker

See Equity Broker descriptions

Broker of Credit

Contains the broker of credit names you create on the workstation, including:
• BOC Name (required)
• Internal ID—for internal mapping purposes only
• DTC Number—a four-digit number for internal mapping purposes only
The Blocks created in this table appear in the Broker of Credit Name and ID drop-down lists in the Allocation Details screen.

Account

Contains the account name you create on the workstation including:
• Account Name (required)
• Account Code (required)
• ALERT Access Code
The Accounts created in this table appear in the Account Name, Account Code, and ALERT Access Code drop-down lists
in the Allocation Details screen.
Each field is tied to a single Account. For example, supposed that you select a specific name in the Account Name dropdown list. OASYS then automatically populates the corresponding Account Code and ALERT Access Code drop-down lists
with the values provided in the Accounts table.

Omnibus Account

Contains the account name you create on the workstation that one merchant carries for another, including:
• Omnibus Account Name—a drop-down list of existing accounts from the Accounts table (required)
• Sub-Account Name (required)
• Sub-Account Code (required)
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Table 3.1 OASYS Tables (continued)
Table

Description

Security Type

Contains available security types for equity and fixed income trades, including:
• Code
• Description
• Asset Class
Each time you connect to the OASYS host, it checks the table against your workstation table and updates the workstation
if necessary.

Holiday

Contains a list of holiday describing when trades and settle dates are allowed and disallowed, including:
• Date
• Trade
• Settle
Each time you connect to the OASYS host, it checks the table against your workstation table and updates the workstation
if necessary.

Generate ASCII Files

Provides a path for you to save the following tables in ASCII (.as) format:
• Equity Broker (oasysbkr.asc)—List contains the Acronyms only.
• Fixed Income Broker (oasysbfi.asc)—List contains the Acronyms only.
• Broker of Credit (oasysboc.asc)—List contains tab-separated BOC Name, Internal ID, and DTC Number.
• Accounts (oasysacc.asc)—List contains tab-separated Account Name, Account Code, and ALERT Access Code.
• Security Type (oasyssec.asc)—List contains the Code only.
• Holiday (oasyshol.asc)—List contains tab-separated Trade Holiday, Settlement Holiday, and Date.

TradeSuite Errors

Contains a list of TradeSuite errors, including:
• Reference
• Seq #
• FieldCode
• ReasonCode
• Description
Each time you connect to the OASYS host, it checks the table against your workstation table and updates the workstation
if necessary.

User-Editable Tables
Table 3.2 describes the tables you can modify and the limitations of those modifications.
Table 3.2 User-Editable Tables
Table

Edit Scope

Equity Broker

Add and update Broker Internal ID or DTC Number only

Fixed Income Broker

Add and update Broker Internal ID or DTC Number only

Broker of Credit

Add, delete, and modify entries

Account

Add, delete, and modify entries

Omnibus Account

Add, delete, and modify entries

View-Only Tables
OASYS uses the following view-only tables:
•

Security Type

•

Holiday
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•

TradeSuite Errors (OASYS-TradeSuite ID)

Note

For OASYS-TradeSuite ID clients: OASYS also uses the Participant table to validate the following
TradeMatch IDs: Institution ID, Broker ID, and Agent ID. This table is on your workstation but it is not
available in the OASYS interface.

Viewing and Printing a Table
The Tables menu lists all of the tables.
•

Select any table on the Tables menu to view it.

•

Select any table on the Tables menu to view it, and then click Print.

Updating Broker of Credit, Account, and Omnibus Account Tables
To create trade allocations, set up an account in the Account table. The Broker of Credit and Omnibus Account
tables are optional.

Batch Load Account Table Data
You can import data for a new Account table, rather than adding or modifying entries for Account Name, Account
Code, and ALERT Access code separately.
To import data:
1. Create a semicolon-delimited load file using a text editor, such as Notepad. For each new or updated entry,
include values for Account Name, Account Code, and ALERT Access Code. For example:
account5;34567;789ab
account6;678912;234567

2. In OASYS, select Account from the Tables menu.
The Account Table dialog box opens.
3. Click Batch Load.
A message advises you to back up the current Account table. Do one of the following:
•

Click No to stop the batch load and back up the table.

•

Click Yes to continue to the next step.

4. A dialog box opens, prompting you to enter the folder that holds the account information to load. Click Browse
to locate the folder with your load file. Then, append the load file name to the folder name and click OK.
OASYS loads the new account entries into the Account table.
If any values in the load file are duplicates of existing Account Table values, the Duplicate Account Handling
dialog box opens. A duplicate can be a file you want to replace or an error in your load file. You can handle each
error or update individually, or you can process the entire load file without prompts.
For example, if you created the load file to update existing Account Table entries, select the Apply This Action
to ALL Accounts check box. Then, click Yes to replace it with the values that appear under “Replace it with
following new info?” and OASYS updates all accounts.

Adding or Modifying Table Entry
You can add and modify entries in the Account, Broker of Credit, and Omnibus Account tables.
To add or modify an entry to a table:
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1. Select the table you want to update from the Tables menu.
2. From the table screen, click New. The corresponding table Entry screen appears.
3. Enter or modify the information shown in appropriate fields.
4. Click OK to save the information and return to the table screen or click Cancel to return to the table screen
without the table modification.

Copying a Broker of Credit Table Entry
You can copy an entry in the Broker of Credit tables.
To copy a table entry:
1. Select the Broker of Credit table from the Tables menu. The Broker of Credit Table appears.
2. Select the entry you want to copy (you can only copy one entry at a time). The Broker of Credit Entry screen
appears.
3. Confirm the copy by assigning the copied table the following on the Broker of Credit entry screen:
•

BOC (Broker of Credit) Name

•

Internal ID

•

DTC Number

4. Click OK to save the copy and return to the table screen or click Cancel to return to the table screen without
saving it.

Validating the Account Table Contents
You validate the contents of the Account table (Figure 3.1) by clicking Modify from the Account Table dialog box.
This validation ensures that table entries sourced from another application contain properly formatted characters.
OASYS can then pass on these entries to the broker/dealers.

Figure 3.1 Account Table Dialog Box

Deleting a Table Entry
You can delete a table entry from an Account, Broker of Credit, and Omnibus Account table.
To delete a table entry:
1. From the Tools menu, select the table in which you want to delete entries.
2. With the table screen displayed, select the entry you want to delete.
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3. Click Delete.

Updating Equity Broker and Fixed Income Broker Tables
You can add, modify, or copy a broker/dealer Internal ID or DTC number in the Equity Broker and Fixed Income
Broker tables. You cannot add broker/dealer names to these tables.
When you add entries to the Equity Broker and Fixed Income Broker tables and download them to your
workstation, your local tables are automatically updated.
You can delete selected broker/dealers, but you cannot delete the last instance of an OASYS broker/dealer from
these tables.

Adding an Internal Broker ID or DTC Number
You can add an internal ID and/or DTC Number to a table entry in the Equity Broker and Fixed Income Broker
tables.
To add an Internal ID and/or DTC Number:
1. From the Tools menu, select the relevant table.
2. From the relevant screen, select an existing broker/dealer and click New. The associated entry screen
appears.
3. Enter the Internal ID and/or DTC Number.
Note

Multiple internal IDs can map to the same long name/acronym/short name combination.

4. Click OK to save the information and return to the table screen or click Cancel to return to the table screen
without saving it.

Modifying an Internal Broker ID or DTC Number
You can modify an Internal ID and/or DTC Number of a table entry in the Equity Broker and Fixed Income Broker
tables.
To modify an Internal ID and/or DTC Number:
1. From the Tools menu, select the relevant table
2. Select an existing broker and click Modify. The associated entry screen appears.
3. Modify the Internal ID and/or DTC Number.
Note

Multiple internal IDs can map to the same long name/acronym/short name combination.

4. Click OK to save the information and return to the table screen or click Cancel to return to the table screen
without saving it.

Copying an Internal Broker ID or DTC Number
You can copy an Internal ID and/or DTC Number of a table entry in the Equity Broker and Fixed Income Broker
tables.
To copy an Internal ID and/or DTC Number:
1. From the Tools menu, select the relevant table.
2. Select an existing broker, and then click Copy. The associated entry screen appears.
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3. Enter the appropriate Internal ID and/or DTC Number.
Note

Multiple internal IDs can map to the same long name/acronym/short name combination.

4. Click OK to save the information and return to the table screen or click Cancel to return to the table screen
without saving it.

Table Backup and Restoration
Use the Backup command to save and restore the Accounts table.

Backing up OASYS Tables
Using the Backup function is not a complete database backup. To back up your database, use the OASYS
MSDE Utility in Start > All Programs > Omgeo OASYS.
To back up the OASYS tables:
1. Ensure that a folder is created in the backup location.
2. Select Backup from the Backup/Restore menu.
3. Specify the destination folder for the backup file.
Note

The default folder is the folder specified the last time the backup procedure was run. If this folder already
contains a backup file, the backup procedure overwrites any data found in it. Therefore, to save the previous
backup folder location, either rename it or specify a different folder.

4. Click OK to run the backup and exit the screen or click Cancel to exit the screen without running the backup.
In a successful backup, the following backup files are put in the selected location.
Account.bck

ExportModel.bck

ImportModel.bck

RefCode.bck

UserConfig.bck
Version.bck

Alloc.bck

Features.bck

Institution.bck

RefIndex.bck

Broker.bck

FeaturesTranslation.bck

InstitutionFields.bck

Schedule.bck

BrokerAdded.bck

FilterField.bck

Omnibus.bck

SortField.bck

BrokerOfCredit.bck

FilterModel.bck

Participant.bck

SortModel.bck

BrokerTranslation.bck

FramesConfig.bck

PurgeList.bck

SystemConfig.bck

CycleEvent.bck

History.bck

RecordFormatFields.bck

TFSRefGen.bck

CycleModel.bck

Holiday.bck

RecordFormats.bck

Trade.bck

Restoring OASYS Tables
You can restore backed-up OASYS tables as long as the files are accessible locally or over your network. Before
you begin the restore, ensure that the tables have not been updated since the most recent backup.
To restore the OASYS tables:
1. Select Restore from the Backup/Restore menu and select either all of the tables or a single table for
restoration.
2. Specify the destination folder that contains the backup file, using either the drop-down list or click Browse to
locate the folder.
Click OK to run the restoration and exit the screen or click Cancel to exit the screen without running the
restarting procedure.
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4. PROCESSING TRADES
Introduction
This chapter describes how to create, edit, and send equity and fixed income trades.

Creating Equity Trades
To create an equity trade in OASYS, you can import block and allocation details or enter them manually. You can
also create, change, or view the information in the Block Details and Allocation Details screens and print various
reports.
For information about importing and exporting trades and models, see the Integration Guide. Also, remember that
you must have an account in the Account table to create trades.

Note

Required Equity Block Details Fields
The following fields are required in the equity Block Details screen:
•

Security ID

•

OASYS Broker or Executing Broker ID

•

Asset Class

•

Trans Type

•

Security Type

•

Trade Date

•

Size

•

Settle Date

For a full description of each equity Block Details screen field, see Working With Trades.
To enter equity block details:
1. Open the OASYS workstation
2. Do one of the following:
•

Click the New Trade icon

on the Trade Summary screen. Alternatively, press CTRL+N.

•

Select New from the Trade menu.
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The Block Details screen appears (Figure 4.1).
.

Figure 4.1 Block Details Screen
3. Select EQ in Asset Class drop-down list. Your selection determines the list of available security types in the
Security Type field and broker/dealers in the OASYS Broker field.
4. Enter the block values.
•

Some fields in this screen are populated from OASYS tables. Ensure that these tables are up-to-date
before entering values. Until Price is entered, the trade status remains INCMPL.

•

OASYS-TradeMatch Users: If your counterparty is an OASYS broker/dealer, it is recommended that
you also enter a value in the Executing Broker ID field.

5. Save the block, create the allocations for the trade, or click Cancel to return to the Trade Summary screen
without saving the block details.
•

If you choose to save the block, click OK. Your new trade appears on the Trade Summary screen with
a status of NALLOC (not allocated). That status is maintained until you allocate all (100%) of the block
and enter a price in the Price field.

•

To continue with the allocation creation, click New to access the Allocation Details page.

Entering Equity Allocations
Before you can allocate a trade, ensure that an Account and a Broker of Credit tables are configured to process
the trade.
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Required Equity Allocation Details Fields
You are required to enter values in the Size field and at least one of these fields:
•

Name

•

Account Code

•

ALERT Access Code

For a full description of each equity Block Details screen field, see OASYS Trade Screens.
To enter equity allocations:
1. Click New in the Block Details screen. The Allocation Details screen appears.
2. Enter the allocation details.
3. Optionally, to set up tax lot information, select a Release Method from the drop-down list.
•

Click New to display the Tax Lot Details screen.

•

On the Tax Lot Details screen, enter the Purchase Price, Purchase Date, Tax Lot ID, and Release
Quantity.

•

Click OK to save the data and return to the Allocation Details screen.

4. Click OK to save the allocations or click Cancel to close the screen without saving the information.
The new trade appears on the Trade Summary screen with a status of ALLOC (allocated). Allocate all
(100%) of the block before sending a trade to the OASYS host.

Figure 4.2 Allocation Details Screen
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Using the Broker of Credit Fields
Use the Broker of Credit section to identify, for example, the executing broker’s correspondent broker. For a
stepout (equity trade only), identify the non-executing broker to whom a commission credit is due. Select a name
in the Name field from the drop-down menu or type a name. The names on the drop-down menu are the names
entered in the Broker of Credit table. See Updating Equity Broker and Fixed Income Broker Tables.
Note

To enable enrichment, a broker/dealer can supply DTCC with a list of broker of credit names and a BIA number for
each. OASYS can then enrich the trade with the BIA number by using this prefix. Enter the broker of credit name
exactly as it appears on the DTCC host.
Always ask your counterparty for the appropriate broker of credit ID. Identify the broker of credit by their short name
(that is, the OASYS acronym). If the broker of credit does not have an OASYS acronym, the 4-letter market
Participant ID (MPID) is used.

Optionally, you can enter the broker’s TradeSuite ID number in the ID field.

Processing Stepouts and Stepins
Stepouts are for equity trades and fixed income trades. A stepout is a way to direct commission dollars from an
executing broker/dealer to another broker/dealer called the stepin broker/dealer.
On the original trade allocation, you indicate whether it is a stepout and if it is for an OASYS or non-OASYS
broker/dealer. You can also filter the stepout allocation details from the stepin broker/dealer.
After the executing broker/dealer accepts the trade, OASYS automatically generates the stepin trade with the
appropriate allocations. The allocations are generated for each OASYS broker/dealer and (for OASYSTradeMatch clients) non-OASYS stepin broker/dealer. The stepin trade appears on your Trade Summary screen
with the status ALLOC.
Note

Stepins are generated for non-OASYS broker/dealers if you are an OASYS-TradeMatch client and the broker/
dealer is a DTCC client. These stepins are sent to TradeMatch only.

Sending Stepouts to an OASYS Broker
To create a stepout trade:
1. In the Block Details screen, enter the Exec Brkr MPID.
2. In the Allocation Details screen, select the Stepout check box.
3. Verify that OASYS Broker is selected. The list for the Broker table is available in the Stepout To field.
4. Select a broker/dealer name from the Stepout To list.
5. Select a Stepin Brkr MPID from the drop-down list.
6. Optionally, enter a clearing number in the Clearing Number field and a code to indicate why the commission
was allocated in the Commission Code field.
7. If you are an OASYS-TradeMatch client, you can:
•

Enter the TM Stepout Broker ID (recommended)

•

Matching only (optional)

8. Click OK to save your stepout or click Cancel to cancel it.
9. Repeat Steps 1 through 6 for each stepout allocation.
After all of the stepouts for your equity trade are entered, return to the Block Details screen. OASYS updates
the screen by automatically selecting the Contains Stepouts check box.
10. To filter the stepout allocation details from the broker, verify that the Filter Stepout Allocation Details check
box is selected.
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Entering Stepouts for a Non-OASYS Broker/Dealer
You can indicate a stepout for a non-OASYS broker/dealer. However, OASYS only generates a stepin if you are
an OASYS-TradeMatch client. In this case, the stepins are sent to TradeMatch only.
To enter a stepout for a non-OASYS broker/dealer:
1. In the equity Allocation Details screen, select the Stepout check box.
2. Clear the OASYS Broker check box.
3. Type a broker code in the Stepout To field.
4. Optionally, type a clearing number in the Clearing Number field, and then type the reason code for the
commission in the Commission Code field.
5. If you are an OASYS-TradeMatch client:
•

Type a value in the TM Stepout Broker ID field.

•

Click Matching Only. Select this field if the stepin is for a non-OASYS-broker/dealer and you want the
trade sent to TradeMatch.

6. Click OK to save your stepout or click Cancel to cancel it.
7. Repeat Steps 1 through 6 for each stepout allocation.
After all of the stepouts for your equity trade are entered, return to the Block Details screen. OASYS updates
the screen by automatically selecting the Contains Stepouts check box.
8. To filter the stepout allocation details from the broker, select the Filter Stepout Allocation Details check box.

Fields Related to Stepouts
Table 4.1 describes the fields related to stepouts.
Table 4.1 Stepout Field Descriptions
Trade (Block) Level
OASYS Broker

(OASYS-TradeMatch only) The OASYS acronym of the executing/broker dealer. The investment manager can choose from
a list of valid OASYS broker/dealers.

Exec Brkr MPID

(OASYS-TradeMatch only) The TradeMatch ID of the executing broker/dealer. This field is required if the executing broker/
dealer is a non-OASYS broker/dealer. It is optional, but recommended, for an OASYS broker/dealer.

Executing Broker MPID#

The Market Participant identification number for the executing broker.

Inst. Comments

An optional field that you can use to type a comment on the trade.

Commission

The agreed-upon commission. The value is .00000001 to 9.99999999.

Filter Alloc Details

Indicates that the investment manager wants to filter the account details of stepout allocations from the executing broker/
dealer. The default is Y.

Allocation Level
Commission Code

A single alphanumeric character. The investment manager can use this field to give a reason code for their commission
direction. The default is N for None. OASYS does not control the vocabulary of these codes as they differ greatly among
investment managers.

Hard/Soft

H (hard) or S (soft) dollar arrangement. If no choice is made, the value defaults to H.

Commission

The commission rate. The value automatically defaults to the commission entered in the Block Details (block level) screen.
You can change the commission for each allocation.

Broker of Credit Name

A non-executing broker/dealer specified by the investment manager to whom commission credit is due.

Broker of Credit ID

The TradeMatch ID of the Broker of Credit. Entered by the investment manager.

Stepout

Indicates whether an allocation is a stepout.

Stepout To

Identifies the broker/dealer who is stepping into the trade. OASYS automatically generates a stepin trade if the Stepout To
field contains a valid OASYS acronym.

Clearing Number

Identifies the clearing number of the stepin broker/dealer. Entered by the investment manager.

OASYS Broker

Indicates whether the broker/dealer in the Stepout To field is an OASYS broker/dealer. The default is Y.
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Table 4.1 Stepout Field Descriptions (continued)
Trade (Block) Level
TM Stepout Broker ID

(OASYS-TradeMatch only) The TradeMatch ID of the broker/dealer in the Stepout To field.

Stepin Ref#

A reference number associated with the stepin.

Matching Only

(OASYS-TradeMatch only) Indicates that the stepin trade is sent to TradeMatch only.

Stepout Comments

Use to enter additional comments on the stepout. For example, you can use this field to enter codes used for ACT reporting.

Stepin Broker MPID

The Market Participant Identification number for the stepin broker.

Entering Options Trades
OASYS option trades have the following features:
•

Security ID field containing up to 21 characters

•

Two security types: Options Contracts (OPC) and Options Shares (OPS)

•

Complies with the Option Clearing Corporation Options Symbology Initiative

The Options trading section consists of two areas:
•

Block Details

•

Options Details

Options Trading: Block Details
To create an options trade:
1. Log in by entering your User ID and Password.
2. On the Active and Today screen, click New Trade. The Block Details screen displays.
3. Using the Asset Class drop-down, select the asset class.
4. Using the Trans Type drop-down, select the transaction type.
5. In the Size field, enter the block size.
6. In the Price field, enter the price per share.
7. Using the Security Type drop-down, select the security type.
8. Using the OASYS Broker drop-down, select your broker. You can access Options Details if the broker you
select is on an appropriate version of OASYS to receive the option fields.

9. Enter the security ID in the Security ID field. The Security ID field contains up to 21 characters. The Security
ID format is:
•

Ticker symbol: up to six upper-case letters, numbers, and spaces

•

Trade date: enter in YYMMDD format

•

C for Call, or P for Put

•

Strike price: up to a five-digit integer, and a three-digit decimal

10. Enter or copy the security ID of the options into the Inst Cmnts (Institution Comments) field.
11. Click Options. The Option Details screen displays.

Options Trading: Options Details
To define options details:
1. Click the Options. The Option Details screen displays.
2. Enter the security ID in the Security ID field; then copy the security ID to the Inst Cmnts field. The Using the
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Options Exchange drop-down, select the option exchange.
3. Using the Option Type drop-down, select call (C), or put (P).
4. In the Option Expiration Date field, enter the expiration date in DD-MMM-YY format.
5. Using the Option Delivery Type drop-down, select the delivery type; either CASH or PHYS (physical).
6. In the Option Premium Amount field, enter the option premium amount.
7. In the Option Strike Price field, enter the option strike price.
8. In the Option Details screen, click OK. You are returned to the Block Details screen.
9. In the Block Details screen, click OK.
The option block record is created, and displays in the Active and Today list. It is now ready to be allocated and
sent to your broker/dealer counterparty.

Creating Fixed Income Trades
To create a fixed income trade in OASYS, you can import block and allocation details or enter them manually.
You can also create, change, or view the information in the Block Details and Allocation Details screens.
For information about importing and exporting trades and models, see the Integration Guide. Also, remember that
you must have the Account table configured before you can create trades.

Note

Required Fixed Income Block Details Fields
The following fields are required in the equity Block Details screen:
•

Security ID

•

OASYS Broker or Executing Broker ID

•

Asset Class

•

Trans Type

•

Security Type

•

Trade Date

•

Size

•

Settle Date

For a full description of each fixed income Block Details screen field, see OASYS Trade Screens.
To enter fixed income block details:
1. Open the OASYS workstation
2. Do one of the following:
•

Click the New Trade icon

on the Trade Summary screen. Alternatively, you can press CTRL+N.

•

Select New from the Trade menu.
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The Block Details screen appears (Figure 4.3).

Figure 4.3 Block Details Screen
3. In the Asset Class drop-down list, select FI for Fixed Income. Selecting FI determines the list of available
securities in the Security Type field and broker/dealers in the OASYS Broker field.
4. In the Security Type field, select the security. If you set a default security type on the Workstation Setup
screen, the field is automatically populated.
If you selected TBA, see Sending TBA Trades for more information.
5. Enter the block details, some of which are required.
Note

Some fields in this screen are populated from OASYS tables. Ensure that these tables are up-to-date before
entering values. Until Price is entered, the trade status remains INCMPL. For more information about trade
statuses, see Processing Stepouts and Stepins.
See also Custom CUSIP Identifier.
OASYS-TradeMatch Users: If your counterparty is an OASYS broker/dealer, it is recommended that you also enter
the Executing Broker ID.

6. Save the block, create the allocations for the trade, or click Cancel to return to the Trade Summary screen
without saving the block details.
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•

If you choose to save the block, click OK. Your new trade appears on the Trade Summary screen with
a status of NALLOC (not allocated). That status is maintained until you allocate all (100%) of the block
and enter a price in the Price field.

•

If you choose to continue with the allocation creation, click New to access the Allocation Details page.

Entering Fixed Income Allocations
Before you can allocate a trade, ensure that an Account and Broker of Credit tables are configured to process the
trade. You are required to enter values in the Size field and at least one of these fields:
•

Name

•

Account Code

•

ALERT Access Code

For a full description of each fixed income Allocation Details screen field, see OASYS Trade Screens.
To enter fixed income allocations:
1. On the Block Details screen, click New.
The Allocation Details screen displays (Figure 4.4).
2. Enter the allocation details.
Enter a value in the Original Face field and one of these fields:
•

Name

•

Account Code

•

ALERT Access Code

3. Optionally, to set up tax lot information, select a Release Method from the drop-down list.
•

Click New to display the Tax Lot Details screen.

•

On the Tax Lot Details screen, enter the Purchase Price, Purchase Date, Tax Lot ID, and Release
Quantity.

•

Click OK to save the data and return to the Allocation Details screen.

4. Click OK to save the allocations or click Cancel to close the screen without saving the information.
The new trade appears on the Trade Summary screen with a status of ALLOC (allocated). Allocate all
(100%) of the block before you can send a trade to the OASYS host.
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For information about using the Broker of Credit fields, see Using the Broker of Credit Fields.

Figure 4.4 Allocation Details Screen

Custom CUSIP Identifier
Both equity and fixed income trades use a custom or user-defined CUSIP identifier. You can identify the custom
CUSIP manually on the workstation screen or in your import file. If the CUSIP is a custom identifier, either do not
add a CUSIP field value to your block record format or leave it blank.
Note

If you are a TradeMatch client, enter a CUSIP to minimize errors. See Custom CUSIP Identifier.
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Valid CUSIP Characters
Table 4.2 describes the allowed and disallowed CUSIP characters.
Table 4.2 Valid CUSIP Characters
Allowed

Disallowed

The letters a-z, A-Z, the numbers 0-9, and the following special Tabs, control characters, new lines, form feeds (non-printing characters), and the
characters: - / ( ) . , + ? <space> @ % >< _ & # following special characters: : (colon) and ; (semi-colon).
It is suggested that you not use single-quotes (‘) or double-quotes (“) in the CUSIP field
because they can cause difficulties when searching for values.

To enter a custom CUSIP:
1. On the Block Details screen, type the custom CUSIP in the CUSIP field.
If the broker/dealer submits the same custom CUSIP identifier, the allocation can match.
2. Select the Custom CUSIP check box.

Sending TBA Trades
You can select TBA (To Be Announced) as a fixed income security type and indicate whether the trade includes
stipulations. Only OASYS 5.0 (and later) broker/dealers can receive TBA trades.
To select a TBA security type:
1. In the Trade Summary screen, select Trade/New.
2. In the Asset Class field, select FI.
3. In the Security Type field, select TBA.
The Stipulations button (on the right) is activated.
4. Enter the block details.
See the Fixed Income Code of Practice at for more information on how to populate the trade.
5. Click Stipulations.
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The Stipulations dialog box appears (Figure 4.5).

Figure 4.5 Stipulations Dialog Box
The Stipulations Fields table describes the Stipulations dialog box fields.
Table 4.3 Stipulations Fields
Value

Description

One Pool Per Million

Indicates that the trade stipulation is $1 million of face amount at the block level.

1 Pool 1 Piece

Indicates there is only one pool for the TBA, up to the federal delivery maximum of $50 million for one pool.

Max Pools Per 100
Million

Indicates the maximum number of pools that can be delivered on the TBA for each 100 million. For example, 05 pool
maximum on a $100 million TBA.

Other Stipulations

A text field to describe a non-standard stipulation.

Working With Trades
You can edit a trade before it has been sent to the OASYS host or after it has been rejected and returned. In
other words, you can edit a trade when the status is:
•

INCOMPL

•

NALLOC

•

ALLOC

•

DUPL

•

REJECT

Deleting and Canceling Trades
You can delete a trade before it has been sent to the OASYS host.
After a trade has been sent to the OASYS host, you cannot delete it. Instead, you can cancel the trade, but only
if you have not yet received an ACCEPT from the broker/dealer.
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Deleting a Trade
You can only delete a trade before it is sent to the OASYS host. If the trade has already been sent to the host,
you can only cancel it.
To delete a trade:
1. In the Trade Summary screen, select the trade you want to delete
2. Select Delete on the Trade menu. Alternatively, you can press DEL key.
3. If you are prompted to verify your decision, click Yes and press Enter.
Note

You are prompted to verify trade deletion only if your workstation system properties are set to confirm delete.

Canceling a Trade
You can cancel a trade that has been sent to the OASYS host until you receive an ACCEPT or REJECT from the
broker/dealer. However, if the trade has not been sent to the host, it can be deleted.
To cancel a trade:
1. In the Trade Summary screen, select the trade you want to cancel, and then do one of the following:
•

Click the Cancel

on the Trade Summary screen. Alternatively, you can press DEL key.

•

Select Cancel from the Trade menu.

The Cancel Trade Comments dialog box appears.
2. Optionally, add a comment or edit the existing comment.
3. Click Yes to save the comment and return to the Trade Summary screen. Or, click No to stop the cancellation,
return to the Trade Summary screen, and retain the original comment, if any.
Once the broker/dealer’s workstation receives the canceled trade, the status changes to CNCLD on your
workstation display.

Viewing and Modifying Block Details
Modify a block only before the associated trade has been transmitted to the OASYS host or after it has been
rejected and returned.
To modify block details:
1. In the Trade Summary screen, double-click the trade you want to view and change.
2. In the Block Details screen, navigate among the data fields to make your changes.
3. Click OK to save the trade details, or click Cancel to return to the Trade Summary screen without saving the
details.

Viewing and Modifying an Allocation
You can modify an allocation before the associated trade has been transmitted to the OASYS host, or after it has
been rejected and returned.
To modify an allocation:
1. In the Trade Summary screen, double-click the trade containing the allocations you want to view and change.
2. In the Block Details screen, select the allocation and click Modify.
3. In the Allocation Details screen, navigate among the data fields to make your changes.
4. Click OK to save the changes or click Cancel to return to the previous screen without saving the changes.
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Duplicating a Trade
If you are entering similar trades, use the Duplicate command to copy an existing trade into a new trade, and
then edit it.
To duplicate a trade:
1. In the Trade Summary screen, select the trade to copy, and then select Duplicate from the Trade menu.
Alternatively, you can press CTRL+Y key.
•

All values, except Brkr Comment and Reference Number, are copied into the new trade

•

OASYS supplies the next available increment values to the Brkr Comment and Reference Number
fields.

•

OASYS sets the status of the new trade to DUPL.

2. If the trade is fully allocated and you have made all of your changes, either click OK or mark the copied trade
as READY.
The status changes either to ALLOC or to READY, depending on whether your system uses the Auto Ready
feature. If the trade is not fully allocated, edit and complete it.
Note

If you open a trade that is not fully allocated and click OK, the status changes to NALLOC. If the trade has no price,
the status changes to INCMPL. Complete the trade before marking it as READY and sending it to the OASYS host

Deleting an Allocation
You can delete an allocation before OASYS transmits the associated trade to the host or after OASYS returns
the allocation as a reject.
To delete an allocation:
1. In the Trade Summary screen, double-click the trade containing the allocation you want to delete.
2. In the Block Details screen, select the allocation.
3. Click Delete. You are prompted to verify trade deletion only if your workstation’s system properties are set to
confirm the trade deletion.

Sending Trades
The OASYS workstation is configured to send trades as soon as they are READY. If your workstation is not
connected to the OASYS host, READY trades are sent during the next scheduled session with the host. See
Scheduling Events for more information about scheduling trade uploads to the host.
To send a trade immediately, select Connect from the File menu and, upon connection to the OASYS host, the
READY trades are sent. Alternatively, you can press F7.

Marking a Trade as READY
Perform these steps if your system is not configured to use the Auto Ready feature.
To mark a trade as READY:
1. In the Trade Summary screen, select the trade.
2. Click Ready on the Trade menu. Alternatively, you can press CTRL+S.
When the trade’s status changes to READY, a purple circle icon appears on the left side of the trade. The
icon indicates that the trade is waiting for transmission to the OASYS host. If the workstation is connected,
the trade is sent immediately.
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If the workstation is not connected to the OASYS host:
•

Click Connect on the File menu to send the trade immediately, or

•

Wait for the workstation to send the trade during the next scheduled session with the OASYS host.

Reversing the READY Status of a Trade
To reverse the READY status of a trade:
1. In the Trade Summary screen, select the trade to reverse.
2. Click Undo Transmit Status on the Trade menu. Alternatively, you can press CTRL+T.
The trade status changes from READY back to ALLOC, making it untransmittable.
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5. IMPORTING AND EXPORTING
Introduction
This chapter outlines the process of integrating the OASYS workstation with your in-house trading system.

What You Need to Do
OASYS offers you the option of automatically importing trade data to and exporting data from the OASYS
workstation. To automate these processes:
•

Decide which type of interface you want to create: a one-way interface for importing data, or a two-way
interface to import and export data.

•

Decide which of following actions to take:

•

•

Specify the field order in the import and export files (OASYS message format), or

•

Use a fixed format (OASYS 3.5 message format).

Use the OASYS workstation to set up the record formats (OASYS format only), import/export models, and,
optionally, the Scheduler.

Then you can import and export the data. Read this chapter for a brief overview of how to set the import and
export processes on the OASYS workstation. For more information, see the Integration Guide.
Note

You can export an allocation when the TradeMatch status changes. If the Export Model is set to Export Modified
Trades Only, the workstation exports the allocation when either the OASYS or TradeMatch status changes.

Setting Up Import and Export Record Formats
To specify the field order in the import and export files, you create the import and export records on the OASYS
workstation. A record format shows the fields in a file and their sequence.
Note

When you set up an Import or Export Model, you indicate that you are using the OASYS message format.

For a trade in OASYS, you create one record for the trade block, and another for its allocations. The fields
required depend in part on your role in the trade and whether you are importing or exporting data.
To create an import or export block record format, select one of the following menu items to open the Record
Formats List screen:
•

File/Import/Block Record Formats

•

File/Import/Allocation Record Formats

•

File/Export/Block Record Formats

•

File/Export/Allocation Record Formats
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When you first open the Record Format Lists screen, it does not contain any record formats (Figure 5.5).

Figure 5.1 Record Formats List Screen
To create a record format, click New to display the Record Format screen (Figure 5.2). On the right, there are
fields that are required and which must be in a certain order. On the left, there is a list of the fields you can add.

Figure 5.2 Import Block Record Format Screen
Except for the few required fields at the beginning of each record, you can arrange the record fields in any order.
You can use either a comma or tab to separate the fields.
There is no limit to how many OASYS import/export record formats you set up or how many records can be in an
import/export file. However, all record formats must meet certain requirements. For example, each record in a
record format category must have a unique name. So you cannot use the same name for two different Import
Block record formats. You can, however, use the same name for an Import Block and Import Allocation record
format.
For more information on the requirements and setting up the record formats, see the Integration Guide.
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Setting Up the Import and Export Models
After you create your trade and allocation record formats, you can set up your OASYS workstation import and
export models. An import model establishes the parameters for a process that imports data into OASYS. An
export model establishes the parameters for a process that exports data from OASYS. To set up these models,
name the import/export files and folders, and select the data format. For the import files, set up the import logs
and folders.
The settings of the import and export models become the defaults for importing and exporting data. Although you
can change these settings at any time, we recommend that you carefully review your requirements before you do
so.
To create your import models, use these screens which are available from the Tools menu:
•

Import Models (Figure 5.3), to view a list of all models, run a model, and access other functions.
Alternatively, you can press CTRL+I.

Figure 5.3 Import Models Screen
•

Import Model Entry (Figure 5.4), to create or modify an import model. On the Data tab, select either OASYS
or OASYS 3.5 message format.

Figure 5.4 Import Model Entry Screen
To create your export models, you use these screens which are available from the Tools menu:

43

Investment Manager User Guide—Version 7.0

•

Export Models (Figure 5.5), to view a list of all models, run a model, and access other functions.
Alternatively, you can press CTRL+E.

Figure 5.5 Export Models Screen
•

Export Model Entry (Figure 5.6), to create or modify an export model.

Figure 5.6 Export Model Entry Screen
You can also use a Filter Model refine an export. For example, you can create a Filter Model for all accepted
trades. If you select Export Modified Trades Only on the Export Model Entry screen (Data tab), OASYS exports
only trades modified since your last export.

Importing and Exporting Files
In addition to setting up the OASYS workstation models, decide whether you want to transfer data manually or
automatically. For a manual transfer, select an option from the File menu (Figure 5.7).

Figure 5.7 Import Command on the File Menu
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To import and export automatically, you use the Scheduled Event tool on the Tools menu. Using this tool, you
can also schedule the following events:
•

A purge of import and export files

•

An override of the scheduled connection times on the Connection Configuration screen

•

The execution of a program that is external to OASYS.

See Scheduling Events for an overview of the Scheduled Event tool and the Integration Guide for details on how
to use the tool specifically for imports and exports. The Integration Guide also explains how to examine and
troubleshoot the import/export session.
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6. SEARCHING FOR TRADES
Introduction
This chapter describes how to search for trades.

About Searching for Trades
You can search for trades several ways:
•

One-time or recurring search scheduling

•

Filtered searches using the filter model

•

Sorted searches results using the sort model

Running One-Time and Recurring Searches
To perform a one-time search:
1. Select Quick Filter on the Tools menu. Alternatively, you can press F2.
The Quick Filter screen appears (Figure 6.1).

Figure 6.1 Quick Filter Screen
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2. Enter the appropriate data in the following criteria fields:
•

Security

•

OASYS Broker

•

Transaction

•

Security Type (All Equity Securities, All Fixed Income Securities, or Specific Security Type)

•

Trade Status

•

Trade Date

•

Reference #

3. To clear the screen and start over, click Clear.
4. After entering your criteria, click Apply or OK to apply the filter.
5. The Trade Summary screen displays the trades that meet your criteria. If no trades meet your criteria, the
Trade Summary screen is blank.
Note

Using Apply keeps the screen open to create another Quick Filter. Return the Trade Summary screen to its original
view by clicking Defaults, and then Apply or OK.

Working with Filter Models
Filter models enable you to filter trades based on the specific criteria.

Creating a Filter Model
1. Select Filter Models on the Tools menu.
2. In the Filter Models screen, click New.
The Filter Model Entry screen appears (Figure 6.2).

Figure 6.2 Filter Model Entry Screen
3. Specify a model name in the Model Name field and, optionally, type a description in the Model Description
fields.
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4. Add a criterion by supplying values in the criteria specification fields:
•

Field Name

•

Operator

•

Value

5. Click Add to move the criterion to the display window.
Note

The Second Value field appears if you select Between as the operator.

6. Repeat this step until you have entered all the criteria for your search.
7. If you add a criterion and want to edit it, select it in the display window. Then, modify the values in the criteria
specification fields. To delete a criterion, select it in the display window, and click Delete.
8. Click OK to save the new filter model and return to the Filter Model screen. Click Cancel to exit and return to
the Filter Model screen without saving the filter model.
9. Click Apply in the Filter Model screen to perform a search with your new filter model.

Modifying a Filter Model
1. Click Filter Models on the Tools menu.
2. In the Filter Models screen, select a filter model and click Modify. The Filter Model Entry screen appears.
3. Make the required changes to the model.
4. Click OK or click Cancel to exit the screen and return to the Filter Models screen.

Copying a Filter Model
1. Click Filter Models on the Tools menu.
2. In the Filter Models screen, select a filter model and click Copy. The Filter Model Entry screen appears.
3. Make the required changes to the model.
4. Click OK or click Cancel to exit the screen and return to the Filter Models screen.

Deleting a Filter Model
1. Click Filter Models on the Tools menu.
2. In the Filter Models screen, select a filter model.
3. Click Delete.
4. Click OK to confirm the filter model deletion or click Cancel to exit the Filter Models screen.
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Creating a Sort Model
Sort models enable you to sort trade record primary and secondary fields automatically by ascending and
descending order.
To create a sort model:
1. Select Sort Models from the Tools menu. The Sort Models screen appears.
2. Click New. The Sort Model Entry screen appears (Figure 6.3).

Figure 6.3 Sort Model Entry Screen
3. Specify a model name in the Model Name field and, optionally, a description in the Model Description field.
4. In the Primary Sort Field drop down list, select a field and then select the Ascending or Descending option
button.
5. Optionally, in the Secondary Sort Field drop-down list, select a field and then select the Ascending or
Descending radio button.
6. Click OK to save the new sort model and return to the Sort Model screen. Click Cancel to exit and return to
the Sort Model screen without saving the sort model.
7. Click Apply in the Sort Model screen to perform a sort with your new sort model.
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7. SCHEDULING EVENTS
Introduction
This chapter describes task and event scheduling and how to control them in OASYS.

About Scheduling Events
OASYS enables you to program your workstation to perform various tasks at specified times with the Schedule
Events tool, also called the Scheduler. You can run tasks or events, either as independent actions or as a
sequence of actions.

Using the Scheduler
The Scheduler also allows you to view, manipulate, and print basic schedule processes.

Viewing Scheduled Events
To view scheduled events:
1. Open the Trade Summary screen.
2. Select Scheduled Events from the Tools menu.
The Scheduled Events screen appears (Figure 7.1).
3. Look at the values in the Next Scheduled Event and Time fields located at the top of the screen to determine
the scheduler time-frame. All times in this screen are shown in a 24-hour format.

Printing Scheduled Events
To print a list of scheduled events:
1. In the Scheduled Events screen, select Scheduled Events from the Tools menu. The Scheduled Events
screen appears.

Figure 7.1 Scheduled Events Screen
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2. Select an event and click Print.

Disabling the Scheduler
There can be occasions when you are required to suspend all scheduler operations.
To disable the scheduler:
•

In the Scheduled Events screen, select the Disable Scheduler check box.

Halting and Restarting a Running Event Process
There can be occasions when you are required to halt, and then restart, an event running in the scheduler.
To halt a running event process:
1. Select Scheduled Events from the Tools menu. The Scheduled Events screen appears.
2. Select the event.
3. Click Stop Process.
To restart a stopped event process:
1. Select Scheduled Events from the Tools menu. The Scheduled Events screen appears.
2. Select the event.
3. Click Run Process.

Disabling and Enabling an Event Process
Disabling an event process removes the event from the scheduler, but does not delete it.
To disable an event process:
1. Select Scheduled Events from the Tools menu. The Scheduled Events screen appears.
2. Select the event.
3. Click Disable Process—the button changes to Enable Process.
To enable an event process:
1. Select Scheduled Events from the Tools menu. The Scheduled Events screen appears.
2. Select the event.
3. Click Enable Process—the button changes to Disable Process.

Deleting an Event Process
In the Scheduled Events screen, select the event process you want to delete, and then click Delete.

Scheduling New Events
You can schedule a range of events including configured connection time overrides, external process
executions, and import/export activities.
Note

To learn more about import/export record and model purge procedures, see the Integration Guide.

.To schedule new events:
1. Select Scheduled Events from the Tools menu. The Scheduled Events screen appears.
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2. In the Scheduled Events screen, click New. The Scheduled Event Entry screen appears.
From this screen, schedule the following:
•

Recurring or one-time override of connection times

•

Recurring or one-time execution of external processes

•

Recurring or one-time record and model imports

•

Recurring or one-time record and model exports

•

Import and export file purging

Scheduling a Connection Time Override
By default, OASYS is configured to connect to each workstation every 30 minutes. All times are in the 24-hour
format.
To schedule a one-time or recurring connection time override:
1. Select Scheduled Events from the Tools menu. The Scheduled Events screen appears.
2. In the Scheduled Events screen, click New. The Scheduled Event Entry screen appears.
3. Click the Connect tab.
The Connect sheet appears (Figure 7.2).

Figure 7.2 The Connect Sheet
4. In the Hangup Delay field, specify the idle time, in minutes and seconds, after which the link to the OASYS
host is automatically terminated.
During overlapping periods, connection information in this field overrides information entered in the
Connection Configuration screen except when this field is blank. In this case, the value defaults to the value
in the Connection Configuration screen.
Note

See for more information about the Connection Configuration screen.

5. Do one of the following:
•

One-time connection override—Click the One Time radio button. Specify the time for the connection
override in the Time field.

•

Recurring override—Click the Recurring option button. Specify the start and end times for the
connection override in the Active Time Range field.

6. Click OK to add the connection override to the schedule and exit the screen or click Cancel to exit the screen
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without adding it.

Scheduling an External Process Execution
Use the External Process property sheet to run an executable or batch (.bat) program external to OASYS. All
times are in the 24-hour format.
To schedule a one-time or recurring external process execution Override:
1. In the Scheduled Events screen, click New. The Scheduled Event Entry screen appears.
2. Click the External Process tab.
The External Process sheet appears (Figure 7.3).

Figure 7.3 External Process Sheet
3. Specify the file name of the external process in the File Name field. Do not include the file path, just the file
name.
Note

If the file name of the external process contains a space, enclose the file name in quotation marks.

4. Do one of the following:
•

One-time connection override—Click the One Time option button. Set the time of execution of the
external process in the Active Time Range field.

•

Recurring override—Click the Recurring option button. Specify the start and end times for the
execution of the external process in the Active Time Range field.

5. Click OK to add execution of the external process to the scheduler and exit the screen or click Cancel to exit
the screen without adding the process.

Purging Import and Export Files
OASYS purges import and export files by checking a specified set of import and export models and deleting all
appropriate files and logs.
Note

Purging works properly only if you selected the Use File Dating check box on the Import and Export Model Entry
screens. OASYS finds only those files that meet the purge criteria when it performs a purge.

Otherwise, OASYS continues to add records to the file, filling up your disk space. To prevent this condition,
develop a routine for cleaning up the files in these folders. Determine settings based on the frequency of imports
and exports, system disk space, and other contingencies.
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To purge import and export files:
1. In the Scheduled Events screen, click New. The Scheduled Event Entry screen appears.
2. Click the Purge Import/Export Files tab.
The Purge Import/Export Files sheet appears (Figure 7.4).

Figure 7.4 Purge Import/Export Files
3. Specify the number of calendar days after an import/export of files on which to purge in the Purge Files After
... Calendar Days field.
4. Specify the time to execute the purge in the Time field.
5. In the Import and Export Models display window, select the model files to purge. Click Add to move it to the
Purge List display window. Repeat this step until you have moved all of the import and export purge models
to the Purge List display window.
Note

If necessary, move models from the Purge List display window back to the Import and Export Models display
window by selecting them and clicking Remove. The Add button changes to the Remove button when your
cursor is in the Purge List display window.

6. Click OK to add the purge to the schedule and exit the screen or click Cancel to exit the screen without adding
it.
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8. CREATING REPORTS AND HISTORIES
Introduction
This chapter describes how to create reports and view histories of OASYS activity.

About Creating Trade Reports
You can create reports for:
•

Trades

•

Imports/exports (see the Integration Guide)

•

(OASYS-TradeMatch) TradeSuite ID statuses

•

(OASYS-TradeMatch) TradeSuite ID errors

Printing Reports
You can print trade reports from the Trade Reports screen for:
•

Selected trades

•

All trades in a filter

You can access the Trade Reports screen from the Trade Summary screen in three ways:
•

Select Reports on the Tools menu, and then Reports.

•

On the Block Details screen, click Print.

•

Press F6.

Printing Reports for Selected Trades
You can print reports for one or multiple trades.
To print selected trade reports:
1. On the Trade Summary screen, select the trades for which you want to print reports.
2. To select consecutive trades, click the first item. Then, while pressing and holding SHIFT, click the last item.
To select trades that are not consecutive, press and hold CTRL, and then click each item.
3. Select Reports from the Tools menu, and then Trade. Alternatively, you can press F6.
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The Trade Reports dialog box appears.

Figure 8.1 (Institution) Trade Reports
4. In Active Models (top of page), select the Filter and Sort field functions as follows:
•

Filter — A filter used to narrow the number of trade reports (the default is Active and Today). To
choose a different filter on the Filter Models screen, select Filter Model on the Tools menu.

•

Sort — A sort order for the selected trades. To choose a different sort order on the Sort Models screen.
select Sort Models on the Tools menu.

5. In Range to Print, select Selected Trades.
6. In the Report Format, select the report you want to print. See the next section, About Report Formats, for a
description of each format.
7. Click Go to view the selected reports.
Note

Click Go before clicking Print, or an error occurs.

8. Click Print to display the Print screen, and then click Print to print the report.
9. To change the size of the font or the default report format, open the System Properties screen and make the
required changes.

Printing Filtered Trade Reports
You can print reports for filtered trades.
To print filtered trade reports:
1. Select Trade from the Tools menu, and then Trade Reports. The Trade Reports dialog box appears.
2. In Active Models (top of page), check the Filter and Sort options:
•

Filter — A filter used to narrow the number of trade reports (the default is Active and Today). To
choose a different filter on the Filter Models screen, select Filter Model on the Tools menu.

•

Sort — A sort order for the selected trades. To choose a different sort order on the Sort Models screen.
select Sort Models on the Tools menu.

3. In Range to Print, select All Trades in Filter.
4. In the Report Format, select the report you want.
5. Click Go to view the selected report.
Note

Click Go before clicking Print, or an error occurs.

6. Click Print to display the Print screen, and then click Print to print the report.
7. To change the size of the font or default report format, go to the System Properties screen.
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Printing a Trade Report from Block Details Screen
From the Block Details screen, you can open the Block Reports screen and print a trade report for the selected
trade.
To print a trade report from Block Details screen:
1. On the Trade Summary screen, double-click a trade to open the Block Details screen.
2. Click Print. The Trade Reports screen opens and displays the Trade and Allocation Detail Report for the
selected trade.
3. The default report format is Trade and Allocation Detail. You can, however, select a different report format.
See the next section, About Report Formats, for a description of each format.
4. Click Print to display the Print screen, and then click Print to print the report.

About Report Formats
On the Trade Reports screen, you can select one of the following report formats described in Report Formats
table. Select one of these formats as the default on the System Properties screen.
Table 8.1 Report Formats
Table Format

Description

Trade Summary Line

A summary of the selected trade blocks, including general trade information fields and the date the trade was
accepted or rejected.

Trade and Allocation Short Report

A summary of all trade blocks and their allocations, including general trade and allocation information fields.

Trade and Allocation Summary

Details on all trade blocks selected (or in the filter) and a summary of their allocations. Includes general trade
and allocation fields, institution, and broker comments and TradeMatch fields.

Trade and Allocation Detail

Details on all trade blocks and their allocations, including the Stepout To and TM Stepout Broker ID.

Changing Report Font Size
You can change the font size for reports to optimizing the print output.
To change a report font size:
1. Select System Properties from the Tools menu. The System Properties screen appears.
2. Open the Settings tab.
3. In Default Report Font Size, select one of these sizes:
•

Smallest

•

Smaller (default)

•

Medium

•

Larger

•

Largest

4. Click OK to save your changes.

Printing Trade History
You can display and print a selected trade history:
To view and print a selected trade history:
1. On the Trade Summary screen, select a trade. Alternatively, you can press F8.
2. Select History from the Trade menu. The Trade History screen, containing the trade report, appears.
3. Click Print to print the trade history or click Cancel to exit the screen without printing it.
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Printing Import/Export Reports
Use the Import/Export reports tool when you expect to see trades imported, and they do not appear on your
workstation. You can quickly scan the general information in the report to identify the problem.
Note

Export reports are not available when using the OASYS message format.

The reports include:
•

Summary of last import

•

Import log report

To print an import/export report:
•

On the Import/Export Reports screen, click OK and then click Print on the Print screen.

About Creating TradeSuite Status Reports
You can use the TradeSuite Status report to view and print reports for the following statuses:
•

Unmatched

•

Matched

•

Stopped Match

•

Stop Match Failed

You can print reports for all trades or selected trades.

Printing TradeSuite Status Reports for All Trades
1. Select Reports from the Tools menu, and then TradeSuite Status. Alternatively, you can press F9. The
TradeSuite Status Report dialog box appears.
2. In Range To Print, select All Trades.
3. In Report Type, select the type of report you want to print.
4. Click Go to view the selected report.
Note

Click Go before clicking Print, or an error occurs.

5. Click Print to display the Print screen, and then click Print to print the report.
6. To change the size of the font or default report format, open the System Properties screen and specify different
settings.

Printing TradeSuite Status Reports for Specific Trades
1. On the Trade Summary screen, select the trades you want to print.
2. To select consecutive trades, click the first item. While pressing and holding SHIFT, click the last item. To
select trades that are not consecutive, press and hold CTRL, and then click each item.
3. Select Reports from the Tools menu, and then TradeSuite Status. The TradeSuite Status Report dialog box
appears.
4. In Range To Print, select Selected Trades.
5. In Report Type, select the type of report you want to print.
6. Click Go to view the selected report.
Note

Click Go before clicking Print, or an error occurs.
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7. Click Print to display the Print screen, and then click Print to print the report.
8. To change the size of the font or default report format, open the System Properties screen and specify different
settings.

About Creating TradeSuite Error Reports
You can use the TradeSuite error report to view and print the following types of reports:
•

All trades

•

Selected trades

The error report also creates a comma-separated value (.csv) file on the C:\ drive.

Printing TradeSuite Error Reports for All Trades
1. Select Reports from the Tools menu, and then TradeSuite Errors. Alternatively, you can press F11. The
TradeSuite Error Report dialog box appears.
2. In Range To Print, select All Trades.
3. In Report Type, select the type of report you want to print.
4. Click Go to view the selected report.
Note

Click Go before clicking Print, or an error occurs.

5. Click Print to display the Print screen, and then click Print to print the report.
The report is also copied to a .csv file in the OASYS 5.0 installation folder.
6. To change the size of the font or default report format, open the System Properties screen and specify different
settings.

Using the .csv File
The TradeSuite Error Report creates a .csv file that you can open in a spreadsheet program such as Microsoft®
Excel® or import to other programs.

Resolving TradeSuite ID Errors
To resolve TradeSuite ID errors, contact the DTCC Client Center. See the OASYS-TradeMatch Service Guide
for more information.
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9. USING OASYS-TRADEMATCH
Introduction
This chapter describes how to use the OASYS-TradeMatch service.

Description of the OASYS-TradeMatch Service
OASYS integrates trade processing with trade comparison for OASYS-TradeMatch clients. You can use OASYS
to send equity and fixed income trades to broker/dealers. After the trade is accepted, OASYS-TradeMatch
automatically submits it to TradeMatch. You no longer have to re-enter and resubmit trades.
You can also send the trade (and/or a stepin trade) exclusively to TradeMatch, whether the broker/dealer is an
OASYS or non-OASYS broker. Trades for non-OASYS broker/dealers are sent only to TradeMatch.

Providing the CUSIP
To minimize edit errors and optimize results from the OASYS-TradeMatch Service, follow these protocols for
equity and fixed income trades.
•

Equity Trades—For equity trades, provide a valid ticker symbol or CUSIP in the OASYS Security ID field
to identify the traded security. This field must not contain any other data and must be supplied in upper
case letters.
If a ticker symbol is supplied, the ticker symbol is translated into the CUSIP of the security. The ticker symbol
is compared to the CUSIP on broker trade input in TradeMatch. If the Security ID field is not identified as or
translated into a valid CUSIP, the OASYS allocation input is edit rejected.

•

Fixed Income Trades—For fixed income trades, provide a valid CUSIP in the CUSIP field to identify the
traded security. The CUSIP field must not contain any other data and must be supplied in upper-case
letters. The ancillary field data is in addition to any required security information provided in the Security ID
field. The CUSIP is compared to the CUSIP on broker trade input in TradeMatch. If the CUSIP is not valid,
the OASYS allocation input is edit rejected.

OASYS Fields Used for Matching
You can populate all of the required and optional fields used for matching in OASYS. Most fields required for
matching are also required in OASYS or, if optional—and blank—determined by the OASYS host or TradeSuite
ID.
Table 9.1 lists the OASYS fields that are required (R), optional (O), or conditional (C) for matching. The table also
indicates if OASYS requires the field and the corresponding field name in TradeMatch. The fields are for both
equity and fixed income trades, except where noted.
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For a complete description of the fields used by TradeMatch, see the OASYS-TradeMatch Service Guide.
Table 9.1 OASYS Fields Used for Matching
OASYS Field

Required/Optional/
Conditional

TradeMatch Uses

Comments

Trans Type

R

Side (Buy/Sell)

Validated in OASYS. Settlement Date

Settlement Date

O

Settlement Date

If blank, OASYS calculates the value (trade date + 3 business days).

Security ID

R

Security Identifier
Number

Not validated in OASYS. May be ticker or CUSIP. In TradeMatch, the
ticker is translated to CUSIP and validated.

Executing Broker ID

C

Broker-Dealer ID #
or Executing Broker/
Dealer Clearing Broker

Validated in OASYS. Value can be different than the ID on the allocation.
If blank, the OASYS host tries to retrieve it from ALERT or the OASYS
client configuration.
Required for non-OASYS broker/dealer.

Submitting Institution ID

O

Institution ID #

Validated in OASYS. Value can be different than the ID on the allocation.
If blank, the OASYS host tries to retrieve it from ALERT or the OASYS
client configuration.
Required for non-OASYS broker/dealer.

Settlement Location

O

Settlement Location

Validated in OASYS. The settlement locations are:
BRC - Broker Custody
DTC - Depository Trust
FED - Federal Reserve Bank
US - United States
EUR - Euroclear
CDS - Canadian Depository
CED - Clearstream
If blank, the OASYS host determines the location.

Institution ID

O

Institution ID #

Validated by OASYS.
If blank, the OASYS host tries to retrieve it from ALERT or OASYS client
configuration. Value can be different than the ID on the block.

Agent ID

O

Agent ID#

Validated by OASYS.
If blank, the system tries to retrieve it from ALERT.

Net Amount

O

Net Settlement Amount If blank, TradeSuite calculates the value.

Size

R

Shares/Face Value

Block

Allocation

Table 9.2 lists those OASYS fields that are optional for matching.
Table 9.2 OASYS Fields Optional for Matching
OASYS Workstation /
Direct Field

Required by OASYS

TradeMatch Uses

Comments

Price

R

Trade Price

Trade Date

O

Trade Date

If blank, OASYS uses the import date.

Security Type

R

Security Type

Type of equity or fixed income financial instrument such as SHP
(preferred shares) and MBS (mortgage-backed securities).

Account Code

C

Institution Internal
Account #

Agent Internal Account

C

Agent Internal
Account #

Block

Allocation

If blank, the system tries to retrieve it from ALERT.
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Table 9.2 OASYS Fields Optional for Matching (continued)
OASYS Workstation /
Direct Field

Required by OASYS

TradeMatch Uses

Comments

BIA#

O

Broker Internal
Account Number

Retrieved from ALERT by the OASYS host if ALERT access code
identified.

SEC Fees

O

SEC/Registration/
Shipping Fees

If blank, calculated by TradeSuite.

Country Tax

O

Country Tax

Local Tax

O

Local Tax

Other Charges

O

Other Charges

Principal

O

Principal Amount

Commission

O

Commission Fee

Accrued Interest-Discount
(fixed income only)

O

Interest

TM Stepout
Broker ID (stepout
for equity only)

C

Broker-Dealer ID #
(on stepin trade)

If blank, calculated by TradeSuite.

Validated by OASYS host. Value used in Executing Broker ID field on
stepin trade.

OASYS and OASYS-TradeMatch Security Types
The OASYS and TradeMatch Security Types table lists the OASYS security types and corresponding
TradeMatch security types. It also indicates if the security type receives enrichment. For example, BIA#, Agent
ID, and Agent Internal Account Number from ALERT.
An asterisk (*) in the BIA Enrichment column of the OASYS and TradeMatch Security Types table indicates that
the security receives BIA enrichment if the BIA cross-reference uses ALL as the security. To help you quickly
locate equity or fixed income securities, equities are shaded.
Table 9.3 OASYS and TradeMatch Security Types
OASYS Security Type

TradeMatch Security Type

Security Type Name

BIA Enrichment

ABS

ABS

Asset-backed Securities

*

ADR

ADR

ADR

X

AGS

AGS

Agencies

*

BAS

BAS

Banker Acceptances

CER

CER

Representative Certificates

CMO

CMO

US CMO

X

Additional ALERT Enrichment
X

X

COB

CDS

US Corporate Bond

X

X

COD

COD

Certificate of Deposit

X

X

COM

CPA

Commercial Paper

X

X

CON

CON

Convertible Bond

*

CPN

CPN

Coupons

CPP

CDS

CorpPrivPl

X

CSH

CSH

US Cash

X

CWR

CSH

US Cash Wire

X

DFI

DFI

DTC Omnibus

EQU

SHS

Equity / Shares

X

FFI

FFI

FED Omnibus

X

FIN

FIN

Finance
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Table 9.3 OASYS and TradeMatch Security Types (continued)
OASYS Security Type

TradeMatch Security Type

Security Type Name

FMR

FMR

Freddie Mac Remics

BIA Enrichment

Additional ALERT Enrichment

FNM

FNM

US FNMA

X

FNR

FNR

FNMARemics

X

FPA

FPA

Face of Prn/Nom Acct

FRM

FRM

Freddie Mac

*

GMR

GMR

GNMARemics

X

GNM

GNM

US GNMA

X

ITS

ITS

InfIdxTsy

MBS

MBS

Mortgage Backed Security

*

MMT

MMI

US Money Market

X

X

MNB

MUN

US Municipal Bond

X

X

MSC

MSC

Miscellaneous

X

X

MTN

MTN

Med Term Note

X

X

NSD

NSD

Sovereign Debt

*

NTE

MTN

Notes

X

X

OMB

OMB

Other Mortgage Backed Sec

OMM

OMM

Other Money

X

X

OPC

OPC

Option Contract

X

OPS

OPS

Option Shares

X

PRC

PRC

Premium Contract

PRP

CDS

Priv Place

PRS

PRS

Premium Shares

OMB

OMB

Other Mortgage Backed Sec

REP

REP

Repurchase

RTS

RTS

Rights

SHP

SHP

Pref Shares

SLA

SLA

Student Loan

TBA

MBS

To Be Announced

*

TBI

TBI

Treasury Bill

X

TEM

TEM

Tax Free M.M

TRB

TRB

Treasury Bond

X

TRN

TRN

Treasury Note

X

TRS

TRS

Trans Ship

X

TRY

GDS

Treasury

X

UNT

UNT

Units

WAR

WTS

Warrants

XCP

XCP

Tax Free Paper

X

*
X

X

X

X
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Accept Received Status
The trade status ACCRCVD indicates that you received the ACCEPT from the OASYS broker/dealer or OASYS
host (if sending to TradeMatch only). It is the final status of the trade. You cannot edit trades with the ACCRCVD
status.
The ACCRCVD status for a trade displays on the Trade Summary Screen.
For OASYS-TradeMatch clients, the ACCRCVD status does not change, regardless of the transmit status of a
trade sent to TradeMatch.
TradeMatch also sends received statuses on the trade and matching statuses on the allocations.

Trade Validation Status Indicators
The Trade Summary Screen displays the symbols described in Table 1.1 to indicate the validation status for
trades sent to TradeSuite.
Only the following symbols in the Trade Summary Screen Fields table are applicable:
•

Yellow Dot

•

Green Up Arrow (solid)

•

Green Up Arrow (hollow)

•

Red Down Arrow

About Match Statuses
OASYS-TradeMatch sends its clients and broker/dealers interim and final matching status information for each
allocation marked for matching.
The statuses are described in the Match Status Descriptions table.
Table 9.4 Match Status Descriptions
Status

Description

Matched

Indicates that the investment manager’s allocation matched the broker/dealer’s trade input. Can be the final status of a trade.
The investment manager and broker/dealer receive this status.

Unmatched

Indicates that the allocation is marked for matching but is not yet matched. The investment manager receives this status, but
broker/dealer does not.
The allocation status remains Unmatched until it is matched or TradeSuite executes a stop match sent by the investment
manager.

StoppedMatch

Indicates that the investment manager sent a stop match request and TradeSuite stopped the matching process. StoppedMatch
can be the final status of a trade.
The investment manager and broker/dealer receive this status. If the custodian was notified of the original trade, it is sent to the
custodian as a CANCEL.

StopMatchFailed

Indicates that the investment manager’s request to stop the match failed. The investment manager does not see a
StopMatchFailed status if the allocation is already Matched.
The investment manager receives this status, but the broker/dealer does not.

Matching Statuses on Allocations
TradeMatch sends OASYS-TradeMatch clients interim and final matching status information for each allocation
marked for matching. It also sends the final matching status information to broker/dealers. The statuses are listed
in Table 9.4.
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Controlling Allocation Matching
By using the To Matching field on the Allocation Details screen, OASYS-TradeMatch investment managers can
control which allocations go to TradeSuite for matching. By default, when a trade is eligible for matching, all
allocations are sent to matching. You can also control which allocations go to the custodian as settlement
notification.

Notifying the Custodian
When you enter a trade, you can indicate whether to send the allocations to the custodian as settlement
notification. You can send all allocations to the custodian automatically or specifically control, which allocations
are sent.
Note

You can send an allocation to the custodian independent of sending the allocation to matching.

Stopping an Allocation Match
When the trade status is ACCRCVD and an allocation is UNMATCHED, an investment manager can send a
request to TradeSuite to stop the matching process for that allocation.
After receiving a stop match request, OASYS returns the status information on matching. What occurs after the
investment manager sends the request depends on the state of the allocation at the time the request is issued:
•

If the allocation is in a trade that is ACCRCVD, marked for matching, and not yet matched, TradeSuite
executes the stop match request.
The allocation status changes to StoppedMatch for the investment manager and broker/dealer. Final status
of the allocation.

•

If the allocation is in a trade that is not ACCRCVD or has already been matched, the investment manager
receives an error message.

•

If the allocation is matched before TradeSuite can execute the stop match request, it informs the
investment manager that the request was denied. The allocation status changes to MATCHED for the
investment manager and broker/dealer. Final status of the allocation.

TradeSuite ID Errors
TradeSuite ID errors are the result of problems with data input or data enrichment.
Before allowing data to be processed, TradeSuite validates certain information. If the trade fails to meet the
criteria, TradeSuite sends an error message. The error is indicated on the Trade Summary screen by a red down
arrow for hard errors or green up arrow (hollow) for soft errors.
You can view the error messages for one trade in the TradeSuite Errors screen. To view and print TradeSuite
errors for one or more trades, select the TradeSuite Errors submenu under Reports on the Tools menu.

Viewing TradeSuite ID Errors
Use the TradeSuite Errors screen to view the hard or soft errors in a trade sent to TradeMatch.
To view TradeSuite ID errors:
1. In the Trade Summary screen, double-click a trade that has TradeSuite ID errors.
2. Click TS Error in the Block Details screen. The TradeSuite Errors screen appears.
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The TradeSuite Errors screen displays the hard and soft errors in a trade sent to TradeMatch. The screen
displays the data fields described in the Table 9.5.
Table 9.5 TradeSuite Errors Screen Data Fields
Data Field

Description

Reference

The reference number that OASYS assigns to the trade.

Seq #

The sequence number of the allocation.

Field Code

TradeMatch field code for the field in error.

Reason Code

TradeMatch code for the error.

Description

TradeMatch description of the error.

Printing TradeSuite ID Errors
On the TradeSuite Errors screen, click Print to print a copy of the errors displayed.

OASYS-TradeMatch Error Codes
Table 9.6 describes the OASYS-TradeMatch error codes. The system sends an eight-byte error code indicating
the reasons why a message failed validation. The code contains two parts:
•

Four-byte field code that identifies the field where an error occurred.

•

Four-byte error reason code that describes the type of error that occurred
Table 9.6 OASYS-TradeMatch Error Codes
Field Code
GABO

CAAQ

CAAA

GAAT

Reason Code

Explanation

9AAE

First character of record must be C if block, D if allocation, or L if trailer.

IAA7

Block Reference Number is missing, contains errors, or does not match allocation.

IAA8

Allocations are missing.

IACH

Duplicate allocation, block is already complete.

IACF

Trailer record is submitted without a corresponding common record.

9AAN

Submitting Institution ID is not set up for TradeMatch.

9AAA

Submitting Institution ID is blank or 0.

IAAE

Submitting Institution has elected not to receive the allocation rejection.

IAEV

Submitting Institution is not a TradeHub subscriber.

9AAN

Institution ID is not set up for TradeMatch.

9AAE

Institution ID on allocation is different than Submitting Institution on block.

9AAF

Institution ID on allocation is 0 or not numeric.

9AAA

Institution ID on allocation is blank.

IAER

Institution ID is not authorized for acronym.

IAAN

Block Reference Number is not unique.

IAA1

Block Reference Number is not unique. It appears on a previously canceled allocation.

IABD

Block Reference Number is not unique. It appears on a previously rejected allocation.

IAA4

Block Reference Number not found in any previous allocation.

IAAN

Allocation Reference Number is not unique.

9AA5

Allocation Reference Number is 0, blank, or not numeric.

CAAB

9AAN

Executing Broker ID is not set up for TradeMatch.

CAA1

9AAF

Executing Broker ID is not numeric.

CAGJ

9AAA

Executing Broker ID is blank.

9AAN

Executing Broker ID is not set up for TradeMatch.
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Table 9.6 OASYS-TradeMatch Error Codes (continued)
Field Code

Reason Code

Explanation

EAAB

9AAE

Matching Only value is not Y or N or Pre-Notify Custodian value is not C or a D.

DAA3

9AAF

Block Size/Original Face is not numeric.

9AAH

Block Size/Original Face is not greater than 0.

IABB

Total allocation Shares/Face value in canceled and original allocation are different.

DAA4

9AAF

Broker of Credit Commission Fee is not numeric (spaces are the only acceptable non-numeric
values).

DAAD

9AAF

Block Price is not numeric.

9AAH

Block Price is not greater than 0.

EAAA

9AAE

Transaction Type is not valid.

EAA6

9AAE

Stepin Broker Notify Indicator must by Y or N.

BAAB

9AAJ

Trade Date is not a valid business day.

IAAH

Trade Date is greater than 250 days in the past.

IAAF

Trade Date is greater than current date.

BAAA
GAAF

GAAD
GAAE

IAAG

Trade Date exceeds current date.

9AAJ

Settlement Date is invalid.

9AAK

Settlement Date is less than Trade Date.

IAA6

Ticker or CUSIP is invalid.

9AAP

Invalid CUSIP format.

9AA5

Ticker or CUSIP is missing.

9AAO

The Security identifier is invalid.

9ABE

The Security identifier is invalid.

9AAQ

The Security identifier is invalid.

9AAE

Settlement Type must be 1, 2, 3, or 4.

9AAE

Security Type is invalid.

9AA5

Security Type is missing.

9AAE

The Security identifier is invalid.

GAAG

9AAE

Cancellation reason code is invalid.

9AAA

Cancellation reason code is invalid.

GAAP

9AAE

Security numbering system is not one of the acceptable values.

GABI

9AAE

Rejection reason code is invalid.

GABL

9AAE

Allocation Commission Type Indicator must be C, F, D, or U.

9AAA

Allocation Commission Type Indicator must be U when Commission Fee and BOC Commission
Fee are greater than 0.

9AAE

Transaction type is invalid.

GABN
GABP

9AAE

System error. Contact the DTCC Client Center.

9AEH

Set is not complete to cancel detail record.

IAA9

Substitution Indicator must be O for Transaction Type 1.

IABA

Substitution Indicator must be C, S, or R for Transaction Type 4.

GABQ

9AAE

Account Name, Account Code, or ALERT Access Code is invalid.

GAGX

9AA5

Submitting Institution ID does not have a corresponding BIC number in TradeSuite.

DAAA

9AAF

Allocation Size/Original Face is not valid.

9AAH

Allocation Size/Original Face is not greater than 0.

IAAJ

Allocation Size/Original Face is greater than 9,999,999.99 and Settlement Location equals
either BRC or DTC.

9AAF

Net Amount is not numeric.

DAAE
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Table 9.6 OASYS-TradeMatch Error Codes (continued)
Field Code

DAAJ

Reason Code

Explanation

9AAH

Net Amount is not greater than 0.

IAAK

For Settlement Location BRC or DTC, the Net Amount must be $9,999,999,999.99 or less.

9AAK

Net Amount for DTC and BRC must be $9,999,999,999.99 or less.

9AAF

Commission is not numeric.

9AAE

When Allocation Commission Type Indicator is D, Commission Fee must be less than 100%.

DAAI

9AAF

Accrued Interest is not numeric.

DAAL

9AAF

Fees is not numeric.

DAAF

9AAF

Principal is not numeric.

GAAS

9AAE

Settlement Location is invalid.

CAAA

IAAW

Institution is not set up for TradeMatch.

CAA2

9AAN

Clearing Broker ID associated with Executing Broker ID is invalid.

CAA5

IAEV

Agent ID is not set up for TradeHub.

IAAE

Agent ID is not set up to receive TradeHub settlement notifications.

IAEO

Agent ID is blank.

CAA6
CAAF

CAAH
CAAN

9AAN

ID Stepin Broker is not eligible for ID processing.

9AAF

ID Stepin Broker is not numeric.

IAAE

Stepin Broker Notify is Y but ID Stepin Broker and its Clearing Broker elected not to receive
institution instructions.

9AAF

Agent ID number is not numeric.

9AAN

Agent is not eligible for ID processing.

9AAN

Broker of Credit is not eligible for ID processing.

9AAF

Broker of Credit is not numeric.

9AA6

Broker of Credit submitted with non-ID Broker of Credit or non-ID Correspondent Broker.

CAAQ

IAER

Submitting Institution ID is not authorized for acronym.

CAAS

9AAE

Non-ID Stepin Broker must be spaces when an ID Stepin Broker is specified.

Stepouts for OASYS-TradeMatch Clients
When using the OASYS-TradeMatch Service, stepin trades can be generated for OASYS and non-OASYS
broker/dealers. Afterward, the stepins are sent to TradeMatch. Stepin trades for an OASYS broker/dealer can be
sent to the broker/dealer for acceptance and then to TradeMatch, or sent to TradeMatch only. Stepins for nonOASYS broker/dealers can be sent to TradeMatch only.
Table 9.7 shows which fields to populate when generating a stepin trade and sending the stepin to either:
•

An OASYS broker/dealer, and then to TradeMatch

•

TradeMatch only

Table 9.7 Stepouts for OASYS-TradeMatch Clients
Equity Allocation Field

A

Stepout To
OASYS Broker

B

C

D

E

F

OASYS acronym

OASYS acronym

OASYS acronym

Broker code

Broker code

Y

Y

Y

N

N

ID

ID

ID

Y

Y

TM Stepout Broker ID

ID

Matching Only

Y

What Happens...
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Table 9.7 Stepouts for OASYS-TradeMatch Clients
Equity Allocation Field

A

B

C

D

E

F

Generates Stepin Trade

Yes

Yes

Yes

Yes

No

Yes

Send Stepin to broker/dealer
and then TradeMatch

Yes

No

Yes

No

No

No

Send Stepin to TradeMatch only

No

Yes

No

Yes

No

Yes

About Notifying the Custodian
When you enter a trade, you can indicate whether to send the allocations to the custodian as settlement
notification. You can send all allocations to the custodian automatically or control specifically which allocations
are sent. See OASYS User Settings for more information about custodian pre-notification.
Note

You can send an allocation to the custodian independent of sending the allocation to matching.

Sending All Allocations to the Custodian
1. Create a trade.
2. On the Block Details screen or in the import file, select Pre-Notify Custodian.
The To Custodian field on all allocations is automatically selected.
To prevent an allocation from being sent to the custodian, select an option on the allocation.
3. Complete the block and allocation details, and then transmit the trade.

Sending Selected Allocations to the Custodian
Select the To Custodian field on the allocation to send the allocation to the custodian.
1. Create a trade.
2. Select the Pre-Notify Custodian check box on the Block Details screen, and then clear the To Custodian
check box on each allocation that you do not want sent to the custodian
Alternatively, you can leave the Pre-notify Custodian field blank on the Block Details screen. Then select
To Custodian check box on each allocation you want sent to the custodian.
3. Complete the block and allocation details, and then transmit the trade.
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A. OASYS TRADE SCREENS
Introduction
This chapter describes the commonly used OASYS screens used in day-to-day trading operations.

Equity Block Details Screen
Use the equity Block Details screen to enter or revise equity block trade information and display a block trade's
allocations.
Table A.1 describes the equity Block Details screen fields.
Table A.1 Equity Block Details Screen Fields
Field

Description

Trade
Security ID (Required)

Ticker symbol or CUSIP for the traded security (uppercase only). Enter a value that the broker/dealer's system
can recognize. Not validated by OASYS, but not validated by TradeMatch.

Asset Class (Required)

Category of assets. OASYS includes two classes: equity (EQ) and fixed income (FI). This selection also
determines the list of available securities in the Security Type field and broker/dealers in the OASYS Broker field.

Security Type (Required)

Type of equity financial instrument. The following securities are classified as equity:
• ADR—American Depository Receipt
• CER—Representative Certificate
• CON—Convertible Bonds (also in fixed income asset class)
• CSH—Cash
• CWR—U.S. Cash Wire
• EQU—Equity
• MSC—Miscellaneous (also in fixed income asset class)
• OPC—Option Contracts
• OPS—Option Shares
• PRC—Premium Contract
• PRS—Premium Shares
• RTS—Rights
• SHP—Preferred shares
• UNT—Units
• WAR—Warrants
See Setting a Default Security Type for more information about configuring a default security type.

Original Face (Required)

Total quantity of shares in the trade.

Price

Price per share for the entire trade. Value: .0000000001 - 999999999.99. Value is 12 digits including the decimal.
No more than 9 digits before the decimal and 10 digits after the decimal (no commas).
Although the Price field is not required for import, it is required to complete the trade. The trade may be fully
allocated, but the trade status remains INCMPL until you enter a price in the Price field.

OASYS Broker or (for OASYSTradeMatch) Executing Broker ID
and Matching Only
(Required)

Valid OASYS acronym for the executing broker/dealer. Required if the trade is sent to an OASYS broker/dealer
for acceptance. Also used to supply enrichment from ALERT.
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Table A.1 Equity Block Details Screen Fields (continued)
Field

Description

CUSIP check box

The security’s unique nine character ID in the CUSIP system. See Valid CUSIP Characters for more information
about CUSIPs.

Custom CUSIP check box

Indicates the CUSIP is user-defined.

When Issued

If checked, indicates a transaction that was made conditionally because the security, although authorized, has
not yet been issued.

Commission

Rate per share, in cents. Becomes the default for all allocations in this trade which do not contain a different
commission. Value: .00000001-9.99999999 (no commas). Value is 10 digits, including decimal. No more
than 1 digit before decimal and 8 digits after.

Trans Type (Required)

An OASYS transaction type, including:
• B—Buy
• BC—Buy Covered
• S—Sell
• SS—Sell Short
• SE—Sell Exempt

Description

Additional text.

Reference #

A number assigned by OASYS to the trade

Trade Date Required)

Trade date, in the format specified by the current import model.

Status

Current status of the trade, in uppercase. See the Status Values section of the Trade Summary Screen Fields
table for more information about status types.

Internal Ref #

Number you define to track a trade in OASYS. Required as part of an update (only) if you do not use Reference
#. Sent to the OASYS host and OASYS broker/dealers.
(OASYS-TradeMatch) This value also populates the NOE/II Institution Order Routing # field on the confirm when
the trade is matched.

Trade Time

Trade time, in the format specified by the current import model.

Settle Date (Required)

Settlement date of the block trade, in the format specified by the current import model. If blank, OASYS
automatically calculates the settlement date based on the Trade Date, default settle date offset, and settlement
holiday calendar.

Exec Brkr MPID

The executing broker’s Market Participant Identification number. This field is only enabled for stepout trades and
if the counterparty is in version 7.0.

TradeSuite
Executing Broker ID

TradeMatch ID of the executing broker/dealer. Required for non-OASYS broker/dealer. Optional, but
recommended, for an OASYS broker/dealer.

Exec Brkr MPID

The executing broker’s Market Participant Identification number

Submitting Institution ID

TradeMatch ID of the submitting institution.

Matching Only check box

When checked, indicates that the trade is sent to TradeMatch only. Required if the executing broker/dealer is a
non-OASYS broker/dealer.

Pre-Notify Custodian check box

When checked, indicates that the trade is sent to a custodian. OASYS broker/dealers do not receive this field.

Comments
Brkr. Comments

Broker/dealer to investment manager information.

Inst. Comments

Investment manager to broker/dealer information.

Stepout
Contains Stepouts check box

Indicates whether the trade contains stepout allocations.

Filter Alloc Details check box

A check mark indicates you want to filter account details from the executing broker/dealer. Selected by default.

Stepin check box

A check mark indicates this trade is an automatically generated stepin trade.

Stepout From

Short name of executing broker/dealer in original trade from which this trade was stepped out.

Primary Ref #

OASYS reference number of original trade from which this trade was stepped out. Not sent to the stepin broker/
dealer.
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Table A.1 Equity Block Details Screen Fields (continued)
Field

Description

Allocation Information
Seq #

Sequence number of allocation within trade.

Account Name

Account name for the allocation assigned by the investment manager.

Account Code

Internal code you use to identify the account. This value is not sent to your counterparty.

Access Code

Identifier assigned to an account by the investment manager. It may contain only the digits 0-9 and the
uppercase alphabetic characters A-Z.

Original Face

Quantity of shares.

Comm

Special concessions.

Status

(OASYS-TradeMatch) TradeSuite matching status

H/S

Hard/Soft dollar indicator.

BOC

Broker of credit name. Displayed if the allocation has a BOC or is a stepout.

S/O

Indicates whether allocation is a stepout. Value is Y if a stepout, N if not a stepout.

Allocation Status
Total Accounts check box

Number of accounts to which the trade is allocated.

Allocated

Size and percentage of trade allocated.

Allocations do not contain uniform
Commissions check box

If selected, the standard commission rate does not apply to these allocations.

Remaining

Size and percentage of trade remaining to be allocated.

Confirm Control #

The DTC control number of the matching confirm.

Buttons
History

Click to display trade history for the allocations.

Stop All Matches

Click to stop all allocation matches.

Stipulations

(TBA trades) Click to open the Stipulations screen and select or enter the type of stipulation: One Pool Per
Million, 1 Pool 1 Piece, Max Pools Per 100 Million, or Other Stipulations.

Print

Click to print a trade report for the block. You must save the block (for example, click OK) before you can print it.

New

Click to create a new allocation.

Modify

Click to modify the Allocation Details screen for the selected allocation.

View

Click to display the Allocation Details screen for a selected allocation.

Delete

Click to delete the selected allocation.

TS Error

(OASYS-TradeMatch) Click to display TradeSuite errors. Displays only when the trade contains TradeSuite
errors.

Equity Allocation Details Screen
You must allocate all (100%) of a block before you can send a trade to the OASYS host.
Table A.2 describes the equity Allocation Details screen fields.
Table A.2 Equity Allocation Details Screen Fields
Field

Description

Account
Name (Required)

Short text description you use to identify the account.

Account Code (Required)

Internal code you use to identify the account.

ALERT Access Code

Account identifier you set in the ALERT database to identify the account.
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Table A.2 Equity Allocation Details Screen Fields (continued)
Field

Description

Broker of Credit
Name

Broker of Credit for a standard allocation or non-OASYS stepin broker/dealer. This field is not validated on the
workstation.

ID

TradeMatch ID of Broker of Credit. Validated by the Broker of Credit table on the workstation.

BIC

Bank Identifier Code approved by the International Organization for Standardization (ISO). It is the unique
identification code of a particular bank.

TradeSuite
Institution ID

TradeMatch ID of the investment manager. If you supply the ID, it is not retrieved from ALERT or the host.
Validated by OASYS.

Agent ID

TradeMatch ID of the agent. If you supply the ID, it is not retrieved from ALERT. Validated by OASYS.

Agent Internal Account

Agent internal account in TradeMatch. If you supply the account, it is not retrieved from ALERT.

Settlement Location

Use to select a valid settlement location. You can set a default on the OASYS Workstation Setup screen.

TradeSuite Processing (check boxes)
To Matching

A check mark sends the allocation to TradeMatch. By default, the check box is selected.

To Custodian

A check mark sends the allocation to the custodian. You can send the allocation to the custodian even if you do
not send it to TradeMatch. By default, the check box is deselected.

Stop Match

A check mark stops the allocation from matching. You can stop the match when the trade is ACCRCVD (the
trade is accepted) and the allocation is UNMATCHED (not yet matched).

Stepout
Stepout check box

A check mark indicates that the allocation is stepped out. When you select this check box, the Misc field in the
Allocation section is grayed out.

Stepout To

OASYS acronym or an 8-digit broker/dealer code of the stepin broker/dealer. OASYS acronym required to send
trade to OASYS broker/dealer for acceptance. See the DTCC Client Center on for a list of broker/dealer codes.

OASYS Broker check box

A check mark indicates an OASYS stepin broker/dealer. If the box is blank, the Stepout To drop-down list is not
available. Validated by OASYS.

Stepin Brkr MPID

Four-letter code indicating the Market Participant Identification number.

Stepin Ref #

Reference number of the automatically generated stepin trade to which this allocation belongs.

Clearing Number

Clearing number of the broker/dealer in the Stepout To field. Not validated by OASYS.

TM Stepout Broker

(OASYS-TradeMatch) TradeMatch ID of the broker/dealer in the Stepout To field. Required for non-OASYS
stepin broker/dealer.

Matching Only

(OASYS-TradeMatch) When selected, indicates that the stepin trade is to be sent to TradeMatch only. Required
if the stepin broker/dealer is a non-OASYS broker/dealer.

Stepout Cmts

Stepout comments. Use to enter additional comments on the stepout.

Allocation
Original Face

Total quantity of shares in the block trade. Values must be expressed as integers. If entered, Percentage is
automatically filled in.

Percentage

Percentage of the block allocated to this account. If entered, then size is calculated and displayed in the Original
Face field.

Commission

Rate per share, in cents. Defaults to the commission rate on the trade (block), but can be overridden.

Principal

The face value amount to be repaid at maturity.
(OASYS-TradeMatch) If you provide a value, it is not overwritten. If the field is blank, TradeMatch calculates the
value.

Net Amount

The gain realized from the trade.
(OASYS-TradeMatch) If you provide a value, it is not overwritten. If the field is blank, TradeMatch calculates the
value.
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Table A.2 Equity Allocation Details Screen Fields (continued)
Field

Description

Fee

Trade fees. A positive numeric value.
(OASYS-TradeMatch) If you provide a value, it is not overwritten. If the field is blank, TradeMatch calculates the
value.

Country Tax

Country taxes applied to the trade. You supply the value.

Local Tax

Local taxes applied to the trade. Added for Buy transactions, subtracted for Sell transactions. You supply the
value.

Other Charges

You supply the value.

Misc

For standard (non-stepout) allocations, a user-defined field that may contain any printable ASCII character. For
stepouts, must be blank or it generates an error.

Commission Code

User-defined code indicating why you allocated the commission. For example, you can enter R to indicate the
commission pays for research.

Hard/Soft

Indicates if the commission is hard or soft dollars. The value is H (hard) or S (soft). The default is H.

Allocation Status
Total Accounts

Number of accounts to which the trade is allocated.

Allocation Internal Ref #

Your internal reference number for the allocation. The maximum number of alphanumeric characters allowed is
12.

Allocated

Size and percentage of trade allocated.

Status

TradeSuite matching status.

Remaining

Size and percentage of the trade remaining to be allocated.

Confirm Control #

DTC Confirm Control # of the matched confirm to this allocation

Tax Lot
Release Method

The tax lot cost basis release method. Values are:
• AVCO—Average Cost
• FIFO—First In, First Out
• HICO—Highest Cost
• LIFO—Last In, First Out
• LOCO—Lowest Cost
• LTHC—Long Term Highest Gain
• MSTG—Minimum Short Term Gain
• SPEC—Specify

Tax Lot Details

Displays the following information:
• Purchase Date—Purchase date of the relieved lot
• Purchase Price
• Tax Lot ID—Unique identifier given to the lot by the agent bank or custodian
• Release Quantity—Number of shares removed from the lot. Used for a partial-release lot.
You can select a record and click Modify, View, or Delete to edit, review, or delete the record.

New

Click to add a new tax lot record.

Modify

Click to change a selected tax lot record.

View

Click to view the details of a selected tax lot record.

Delete

Click to delete a selected tax lot record.
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Fixed Income Block Details Screen
Use the fixed income Block Details screen to enter or revise fixed income block trade information and display a
block trade's allocations.
Table A.3 describes the fixed income Block Details screen fields.
Table A.3 Fixed Income Block Details Screen Fields
Field

Description

Trade
Security ID (Required)

Ticker symbol or CUSIP for the traded security (uppercase only). Enter a value that the broker/dealer's system
can recognize. Not validated by OASYS, but not validated by TradeMatch.

Asset Class (Required)

Category of assets. OASYS includes two classes: equity (EQ) and fixed income (FI). This selection also
determines the list of available securities in the Security Type field and broker/dealers in the OASYS Broker field.

Security Type (Required)

Type of fixed income financial instrument. The following securities are classified as fixed income:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

ABS—Asset Backed Securities
AGS—Agencies
BAS—Banker Acceptances
CMO—US Collateralized Mortgage Obligations
COB—US Corporate Bond
COD—Certificate of Deposit
COM—Commercial Paper
CON—Convertible Bonds
CPN—Coupons
CPP—CorpPrivPl
DFI—DTC Omnibus
FFI—FED Omnibus
FIN—Finance
FMR—Freddie Mac Remics
FNM—US FNMA
FNR—FNMARemics
FPA—Face of Prn/Nom Acct
FRM—Freddie Mac
GMR—GNMARemics
GNM—US GNMA

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

ITS—InfIdxTsy
MBS—Mortgage Backed Securities
MMT—US Money Markets
MNB—US Municipal Bonds
MSC—Miscellaneous
MTN—Med Term Notes
NSD—Sovereign Debts
NTE—Notes
OMB—Other Mortgage Backed Securities
OMM—Other Money
PRP—Priv Place
REP—Repurchase
SLA—Student Loan
TBA—To Be Announced
TBI—Treasury Bill
TEM—Tax Free MM
TRB—Treasury Bond
TRN—Treasury Note
TRS—Trans Ship
TRY—Treasury
XCP—Tax Free Paper

See for more information about configuring a default security type.
Original Face (Required)

OASYS Broker ID or, for TradeMatch users Executing Broker ID and Matching Only. Valid OASYS acronym for
the executing broker/dealer. Required if the trade is sent to an OASYS broker/dealer for acceptance. Also used
to supply enrichment from ALERT.

Price

Price per share for the entire trade. Value: 0000000001 - 999999999.99. Value is 12 digits including decimal.
No more than 9 digits before the decimal and 10 digits after the decimal (no commas).
Although the price is not required for import, it is required to complete the trade. The trade may be fully allocated,
but the trade status remains INCMPL until you enter a value in the Price field.

OASYS Broker (Required)

Valid OASYS acronym for the executing broker/dealer. Required if the trade is sent to an OASYS broker/dealer
for acceptance. Also used to supply enrichment from ALERT.

CUSIP

The security’s unique nine character ID in the CUSIP system. See for more information about CUSIPs.

Custom CUSIP

Indicates the CUSIP is user-defined.

When Issued

If checked, indicates a transaction that was made conditionally because the security, although authorized, has
not yet been issued.
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Table A.3 Fixed Income Block Details Screen Fields (continued)
Field

Description

Commission

Rate per share, in cents. Becomes the default for all allocations in this trade which do not contain a different
commission. Value: .00000001-9.99999999 (no commas). Value is 10 digits, including decimal. No more
than 1 digit before decimal and 8 digits after.

Trans Type (Required)

An OASYS transaction type, including:
•
B—Buy
•
BC—Buy Covered
•
S—Sell
•
SS—Sell Short
•
SE—Sell Exempt

Description

Additional text.

Reference #

A number assigned by OASYS to the trade.

Trade Date (Required)

Trade date, in the format specified by the current import model.

Status

Current status of the trade, in uppercase. See the Status Values section of the Trade Summary Screen Fields
table for more information about status types.

Exec Brkr MPID

The executing broker’s Market Participant Identification number

Internal Ref #

Number you define to track a trade in OASYS. Required as part of an update (only) if you do not use Reference
#. Sent to the OASYS host and OASYS broker/dealers.
(OASYS-TradeMatch) This value also populates the NOE/II Institution Order Routing # field on the confirm when
the trade is matched.

Trade Time

Trade time, in the format specified by the current import model.

Settle Date (Required)

Settlement date of the block trade, in the format specified by the current import model. If blank, OASYS
automatically calculates the settlement date based on the Trade Date, default settle date offset, and settlement
holiday calendar.

TradeSuite
Executing Broker ID

TradeMatch ID of the executing broker/dealer. Required for non-OASYS broker/dealer. Optional, but
recommended, for an OASYS broker/dealer.

Submitting Institution ID

TradeMatch ID of the submitting institution.

Matching Only

When checked, indicates that the trade is sent to TradeMatch only. Required if the executing broker/dealer is a
non-OASYS broker/dealer.

Pre-Notify Custodian

When checked, indicates that the trade is sent to a custodian. OASYS broker/dealers do not receive this field.

Fixed Income
Accrued Int./Discount

Interest accumulated between the most recent payment and the sale of the security.

Net Amount

The gain realized from the trade.

Issue Date

Date the bond was issued, in the format specified by the current import model.

Principal

The face value amount to be repaid at maturity.

Pool

Pool ID. Applies to mortgage-backed securities. No special characters allowed.

Maturity Date

Date on which the security is due and payable, in the format specified by the current import model.

Current Face

Current amount of principal outstanding on a security.

Coupon Rate

Interest rate of the instrument.

Discount Rate

Indicates the discount rate. May be a negative value.

Final Coupon Rate

Indicates whether the coupon rate is final.

Yield

Rate of return (yield to maturity).

Factor

Pay up/down rate of the security.

Final Factor

Indicates whether the factor is final.

Comments
Brkr. Comments

Broker/dealer to investment manager information.
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Table A.3 Fixed Income Block Details Screen Fields (continued)
Field

Description

Inst. Comments

Investment manager to broker/dealer information.

Allocation Information
Seq #

Sequence number of allocation within trade.

Account Name

Account name for the allocation.

Account Code

Internal code you use to identify the account. This value is not sent to your counterparty.

Access Code

ALERT access code.

Original Face

Quantity of shares.

Comm

Special concessions.

Status

(OASYS-TradeMatch) TradeSuite matching status.

H/S

Hard/Soft dollar indicator.

BOC

Broker of credit name. Displayed if the allocation has a BOC or is a stepout.

S/O

Indicates whether allocation is a stepout. Value is Y if a stepout, N if not a stepout.

Allocation Status
Total Accounts

Number of accounts to which the trade is allocated.

Allocated

Size and percentage of trade allocated.

Allocations do not contain uniform
Commissions

If checked, the standard commission rate does not apply to these allocations.

Remaining

Size and percentage of trade remaining to be allocated.

Confirm Control #

Displays the DTC Control number of the matching confirm.

Buttons
History

Click to display trade history for the allocations.

Stop All Matches

Click to stop all allocation matches.

Stipulations

(TBA trades only) Click to open the Stipulations screen and select or enter the type of stipulation: One Pool Per
Million, 1 Pool 1 Piece, Max Pools Per 100 Million, or Other Stipulations.

Print

Click to print a trade report for the block. You must save the block before you can print it.

New

Click to create a new allocation.

Modify

Click to display the Allocation Details screen for the selected allocation.

View

Click to display the Allocation Details screen for a
selected allocation.

Delete

Click to delete the selected allocation.

TS Error

(OASYS-TradeMatch) Click to display TradeSuite errors. Displays only when the trade contains TradeSuite
errors.

Stepout
Contains stepout check box

Indicates whether the trade contains stepout allocations.

Filter Alloc Details check box

A check mark indicates you want to filter account details from the executing broker/dealer. Selected by default.

Stepin check box

A check mark indicates this trade is an automatically generated stepin trade.

Stepout From

Short name of executing broker/dealer in original trade from which this trade was stepped out.

Primary Ref #

OASYS reference number of original trade from which this trade was stepped out. Not sent to the stepin broker/
dealer
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Table A.3 Fixed Income Block Details Screen Fields (continued)
Field

Description

Tax Lot
Release Method

The tax lot cost basis release method. Values are:
• AVCO—Average Cost
• FIFO—First In, First Out
• HICO—Highest Cost
• LIFO—Last In, First Out

•
•
•
•

LOCO—Lowest Cost
LTHC—Long Term Highest Gain
MSTG—Minimum Short Term Gain
SPEC—Specify

Tax Lot Details

Displays the following information:
• Purchase Date—Purchase date of the relieved lot
• Purchase Price—Purchase price of the relieved lot
• Tax Lot ID—Unique identifier given to the lot by the agent bank or custodian
• Release Quantity—Number of shares removed from the lot. Used for a partial-release lot.
You can select a record and click Modify, View, or Delete to edit, review, or delete the record.

New

Click to add a new tax lot record.

Modify

Click to change a selected tax lot record.

View

Click to view the details of a selected tax lot record.

Delete

Click to delete a selected tax lot record.

Additional Fields for Repurchase Agreements
A repo (repurchase agreement) involves a borrower selling securities to another party at a fixed price, with an
agreement to repurchase the securities at an agreed future date and price. In OASYS, the repurchase
agreement functionality is available on the block level for fixed income trades when you select a REP or FIN
Security Type. When these conditions are met and the broker can process a repo trade, the Repo button is
available on the right side of the Block Details screen. Click Repo to open the Repo Trade screen.
Table A.4 describes the fields.
Table A.4 Repo Trade Screen Fields
Field

Description

Trade Type

Identifies the type of repo trade. Values are:
• Repo
• Reverse Repo
• Sell/Buy Back
• Participation
• Sec Lending
• Sec Borrowing

Delivery Methods

Delivery method based on the security type or purpose of trade. Values are:
• Free
• Book Entry
• Physical
• DVP/RVP
• Cash
• Hold-in-Custody
• Tri-Party
• Quad-Party
• Other
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Table A.4 Repo Trade Screen Fields
Field

Description

Leg Identifier

Identifies whether the transaction is the start (open leg), close (close leg) or both. Values are:
• Open Leg
• Close Leg
• Both Legs

Rate Type

Specifies whether the rate is fix or variable. Values are:
• Original
• Substitution
• Margin-Re-Price/Cash Call
• Margin-Re-Price/Collateral Call
• Rollover
• Other
• Not Specified

Fixed Income Allocation Details Screen
Use the fixed income Allocation Details screen to add or modify a fixed income block's allocations.
Before you can allocate a trade, ensure that an account and broker of credit are configured to process the trade.
To configure those components, see Updating Broker of Credit, Account, and Omnibus Account Tables.
Table A.5 describes the fixed income Allocation Details screen fields.
Table A.5 Fixed Income Allocation Details Screen Fields
Field

Description

Account
Name

Short text description you use to identify the account.

Account Code

Internal code you use to identify the account.

ALERT Access Code

Account identifier you set in the ALERT database to identify the account.

Broker of Credit
Name

Broker of Credit for a standard allocation or non-OASYS stepin broker/dealer. This field is not validated
on the workstation.

ID

TradeMatch ID of Broker of Credit. Validated by a table on the workstation.

BIC

Bank Identifier Code that identifies a financial institution or entity within a financial institution. A BIC, as
specified by the ISO 9362 standard, consists of either eight (BIC8) or 11 (BIC11) contiguous
characters.

TradeSuite
Institution ID

TradeMatch ID of the investment manager. If you supply the ID, it is not retrieved from ALERT or the
host. Validated by OASYS.

Agent ID

TradeMatch ID of the agent. If you supply the ID, it is not retrieved from ALERT. Validated by OASYS.

Agent Internal Account

Agent internal account in TradeMatch. If you supply the account, it is not retrieved from ALERT.

Settlement Location

Use to select valid settlement location. You can set the default on the OASYS Workstation Setup
screen.

TradeSuite Processing (check boxes)
To Matching

Click to select and send the allocation to TradeMatch. The default is selected.

To Custodian

Click to select and send the allocation to the custodian. You can send the allocation to the custodian
even if you do not send it to TradeMatch. The default is deselected.
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Table A.5 Fixed Income Allocation Details Screen Fields (continued)
Field

Description

Stop Match

Click to select and stop the allocation from matching. You can stop the match when the trade status is
ACCRCVD (that is, the trade is accepted) and the allocation is UNMATCHED (not yet matched).

Allocation
Original Face

Total quantity of shares in the block trade. Values must be expressed as integers. If entered, the
Percentage field is automatically populated.

Accrued Interest

Interest accumulated between the most recent payment and the sale of the security.

Discount Rate

Interest rate a central bank charges depository institutions that borrow reserves from it.

Percentage

Percentage of the block allocated to this account. If entered, then size is calculated and displayed in
the Original Face field.

Commission

Rate per share, in cents. Defaults to the commission rate on the trade (block), but can be overridden.

Commission Type

Type of commission arrangement: Introduced Brokerage (INBR), Commission Recapture (CREC),
Commission Sharing Arrangement (CSHA), and Independent Research (INRE). This field is available
if you select S (soft) in the Hard/Soft field.

Principal

The face value amount to be repaid at maturity.
(OASYS-TradeMatch) If you provide a value, it is not overwritten. If the field is blank, TradeMatch
calculates the value.

Net Amount

The gain realized from the trade.
(OASYS-TradeMatch) If you provide a value, it is not overwritten. If the field is blank, TradeMatch
calculates the value.

Fee

Trade fees. A positive numeric value.
(OASYS-TradeMatch) If you provide a value, it is not overwritten. If the field is blank, TradeMatch
calculates the value.

Country Tax

Country taxes applied to the trade. You supply the value.

Local Tax

Local taxes applied to the trade. Added for Buy transactions, subtracted for Sell transactions. You
supply the value.

Other Charges

You supply the value.

Misc

For standard (non-stepout) allocations, a user-defined field which may contain any printable ASCII
character. For stepouts, it must be blank or it generates an error.

Accrued Int/Disc.

Interest accumulated between the most recent payment and the sale of the security.

Hard/Soft

Indicates if the commission is hard or soft dollars. The value is H (hard) or S (soft). The default is H.

Pool Details
Factor

The pay up/down rate of the security.

CUSIP

The security's unique nine character ID in the CUSIP (Committee on Uniform Securities Identification
Procedures) system. Alpha numeric field that allows letters, numbers, and some punctuation
characters.

Issue Date

Date on which a security is originally formed.

Current Face

The current amount of principal outstanding on a security, which is calculated by multiplying the original
face value by the most recent factor.

Pool

Pool ID. Applies to mortgage-backed securities. Alphanumeric field. No special characters are allowed.

Maturity Date

Date on which the security is due and payable, in the date format specified by the import.

Stepin
Stepout

A check mark indicates that the allocation is stepped out. When you

Stepout To

OASYS acronym or an eight-digit broker/dealer code of the stepin broker/dealer. OASYS acronym
required if you want the trade sent to OASYS broker/dealer for acceptance.

OASYS Broker

A check mark indicates an OASYS stepin broker/dealer. If the field is not selected, the Stepout To dropdown list is not available. Validated by OASYS.

Stepin Brkr MPID

Four-letter code indicating the Market Participant Identification number.
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Table A.5 Fixed Income Allocation Details Screen Fields (continued)
Field

Description

Stepin Ref #

Reference number of the automatically generated stepin trade to which this allocation belongs.

Clearing Number

Clearing number of the broker/dealer in the Stepout To field. Not validated by OASYS.

TM Stepout Broker

(OASYS-TradeMatch) TradeMatch ID of the broker/dealer in the Stepout To field. Required for nonOASYS stepin broker/dealer.

Matching Only

(OASYS-TradeMatch) When selected, indicates that the stepin trade is to be sent to TradeMatch only.
Required if the stepin broker/dealer is a non-OASYS broker/dealer.

Stepout Cmts

Stepout comments. Use to enter additional comments on the stepout.

Stepout

A check mark indicates that the allocation is stepped out. When you select this field, the Misc field is
not available.

Allocation Status
Total Accounts

Number of accounts to which the trade is allocated.

Allocation Internal Ref #

Your internal reference number for the allocation. The maximum number of alphanumeric characters
allowed is 12.
(OASYS-TradeMatch) This number populates the Detail Reference Identifier on the confirm. If you
do not supply an internal reference number, the OASYS allocation sequence number is used.

Confirm Control #

Displays the DTC Control number of the matching confirm.

Allocated

Size and percentage of trade allocated.

Status

TradeMatch matching status

Remaining

Size and percentage of the trade remaining to be allocated.

Tax Lot
Release Method

The tax lot cost basis release method. Select a value from the drop-down list. Values are:
• AVCO—Average Cost
• FIFO—First In, First Out
• HICO—Highest Cost
• LIFO—Last In, First Out
• LOCO—Lowest Cost
• LTHC—Long Term Highest Gain
• MSTG—Minimum Short Term Gain
• SPEC—Specify

Tax Lot Details List

This list displays the Purchase Price, Purchase Date, Tax Lot ID number, and Release Quantity for the
tax lot records. You can select a record and click Modify, View, or Delete to edit, review, or delete the
record.

New

Click to add a new tax lot record.

Modify

Click to change a selected tax lot record.

View

Click to view the details of a selected tax lot record.

Delete

Click to delete a selected tax lot record.

Trade History Screen
Use the Trade History screen to review dates and times of the various processing stages of a trade. The entire
OASYS process is presented in the Trade History screen in display-only fields.
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To open the Trade History screen:
1. Open the Block Details screen for a trade.
2. Click History. Figure A.1 shows an example of the Trade History screen.

Figure A.1 Trade History Screen

Understanding Trade History Fields
The Trade History Display Fields table describes the Trade History display fields.
Table A.6 Trade History Display Fields
Display Field

Description

Reference No.

Transaction reference number assigned by OASYS.

Import

Import date and time of the trade — it will contain data only if the trade data is entered from an import session.

Export

Export date and time — it will contain data only if the trade is exported during an export session.

Creation Date

Date and time the trade was originally entered or imported.

Trade Date

Trade date and time.

Settlement Date

Settlement date of the trade.

Sent by Institution

Date and time your counterparty's workstation sent the trade to the OASYS host.

Received by Broker

Date and time you received the trade on your workstation.

Sent by Broker

Date and time the last change you effected was sent to the OASYS host.

Accepted

Trade acceptance date and time.

Rejected

Trade rejection (if any) date and time.

Import/Export Reports Screen
Use the Import/Export Reports screen to print a set of import/export reports.
To open the Import/Export Reports screen:
1. In the Trade Summary screen, click Reports on the Tools menu, and then Import/Export.
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Figure A.2 shows an example of the Import/Export Reports screen.

Figure A.2 Import/Export Reports Screen

Understanding Import/Export Reports Fields
Table A.7 describes the Import/Export Reports screen fields.
Table A.7 Import/Export Reports Screen Fields
Field

Description

Report Format
Summary of Last Import/Export

If selected, the OASYS File Import/Export Statistics report prints.

Log Report
Import Model

If selected, the Transfer Log report prints.

Export Model

Not available when you use OASYS record format.

Model Name

Select a model name of the Import Model on which the log report is being run.

File Name

Displays the Log File name which corresponds to the Import Model you selected.

Date

The date of the log file you want printed. Date must be within range of current date minus 30 days.

Range
All Sessions

If selected, all import or export sessions are included on the log report.

Select Sessions

If selected, click OK to display the Sessions screen.

Type
Detail and Summary

If selected, prints both trade detail and summary on the Import or Export Log report.

Detail Only

If selected, prints only the trade detail on the Import or Export Log report.
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Import/Export Record Formats Screen
There are four screens used to import and export block and allocation formats—full model import and export are
described in the Integration Guide.
You can either view existing formats that may have been created or create a new format. These are the types of
formats you can create.
•

Import — Block Record Formats and Allocation Record Formats

•

Export — Block Record Formats and Allocation Record Formats

To open the Import/Export Record Formats screen:
1. Open the OASYS workstation.
2. On the File menu, select the appropriate Import or Export, depending on which function you require. The
Record Formats List appears for the import or export function you selected.
3. Click New to create a new record format.
Figure A.3 shows an example Import Block Record Format screen.

Figure A.3 Example (Import Block) Record Format Screen

Understanding Record Format Screens
The screens for each import/export record formatting function are identical with the exception of the available
fields you can select to import and export. See the Integration Guide for more information about the import/export
record function.
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Email DTCC Learning at:
DTCCLearning@dtcc.com
or visit us on the web at:
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